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INTRODUCTION

My goal in this book is to give you the tools you need to do
just about anything you want to do with an image. [ bor-
row from many different styles and schools of printmaking
and especially from the conventional darkroom. Even so, |
don't expect that your digital prints will replace those you
might make in the darkroom, any more than they’ll replace
the feel and look of an etching, woodblock print, or plat-
inum print. Digital technology allows us to emulate those
styles, but each print you create should belong to you and
be a unigue manifestation of how you perceive the world.
Printing is an integral part of your photography and
completes the creative circle you initiated when you first
snapped the shutter. When you learn what it takes to
make a good print, you begin to make better pictures in
the camera, if only to avoid the hassle of always correct-
ing poor exposures. In this book I provide effective tech-
niques that you can use to make expressive prints that
both satisfy you and encourage others to share in your vi-
sion. Printing is subjectivity with an underlying discipline
of technique, and an important part of learning to print is
knowing how you want the final image to look. This

means that you should first determine the character of the
final print you desire, then go about using your tools and
techniques to make the print express those visual ends.
This method allows you to fine-tune your work and add
those touches that impart a distinctive and effective evo-
cation of each and every subject and scene.

I have been using this form of printmaking for almost
seven years, which [ suppose makes me a veteran. Before
that, I pursued a passion for silver black-and-white print-
ing—and made a living from it—for almost twenty years.
In this book [ have distilled a series of techniques from
my experiences, which at times have been fruitful as well
as frustrating, to ease the pain and make digital mono-
chrome printing fairly easy for you. If you follow the basic
steps | cover and apply the techniques to your own work,
[ trust that you'll find that they allow you full expression
without too many complications.

My approach is to make the craft of digital printmaking
as simple as possible. This does not mean that [ take the
path of least resistance. [ have too many new things to
learn and processes to work with to say that the path is

The range of lonal values, [he play
of contrast, and the overall
impressior of this print made
fram g scanned color slide all
speak o the effectiveness of
expression of the digital printing
rmedium. Note the textura
nighlight, open shadows, and play
af light that inform the image.
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easy. But I do shy away from special effects for their own
sake and rarely use artistic filters to jazz up an image. As |
iry to demonstrate throughout this book, I do my best to
make the process uncomplicated. My feeling is that as
photographers we should not spend all our time in front
of a computer screen. But we should use the tools and
techniques digital technology provides to get the most we
can from each image.

[ assume that you are not reading this book, and mak-
ing prints, in order to spend all your time wrestling with a
computer and software programs. | only began to enjoy
working with digital photography when [ developed a
method for getting what [ wanted relatively quickly—one
that did not get me mired in endless manipulation and
multiple steps. When [ used to teach silver printing I was
conscious of paper waste (and expense) and used a three-
print-to-final-print approach (test strip print, study print,
and final print). I don’t have much concern about paper
waste here, as the screen or virtual image becomes the
test and study print, but I do have a concern about an-
other type of waste—wasted time.

Effective prints rely on a number of factors—tonality,
contrast, and exposure—to express fully what you want
to say about the subject in the photograph. In some cases
this might mean working with a high-contrast rendition;
in others it might mean working with a full tonal range or
even obscuring parts of the image to create a center of
light on your main subject. You might add a color tone to
one image that would be totally out of place with another.
When you first begin printing you may find it difficult to
decide upon the approach to take. The common wisdom
is that form should follow function; let the subject matter
guide you on your way. In truth, there are no hard-and-
fast rules in this game, and you might find that your deci-
sions are hased more upon how you feel when you're
printing than on any dictum laid down here or elsewhere.
Your final decisions should be more emotional than aca-
demic, based more on who you are than whom you ad-
mire. | can assure you of one thing—over time, especially
over the course of a number of years, how you print an
image today will be quite different from how you see it
and print it later.

This print is from a negative exposed in 1972, Having printed it numerous Limes in the convenlional darkroom,
| can attest to the fact that | had mare control, and & much easier time of it, when | printed it using digital
technigues in the late nineties. Many photographers will use the digital darkroom to revisit old negatives and
slides and make new interpretations.
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KEEP A PRINT DIARY

One of the best aids in becoming a good printmaker is
keeping a print diary. This collection might include images
you've made of different subjects on a wide variety of
papers, all printed with different exposures and contrast
interpretations. Your diary might include different types of
images—a nature scene, an urban landscape, a portrait, a
fashion shot, an abstract, and so an. When you're working
on a print and stuck about which way to go, take the time
to pull out these archetypes and consider your approach.
A catalog from a gallery show might open your eyes; a
new approach might emerge from studying old hand-
colored prints or charcoal studies. Do what excites you
and you won't go wrong. The great thing about digital
technology is the way it encourages risk taking and
experimentation, a process that can often lead to finding
your own personal style.

The ease with which you can vary the values and tones in
your image is what makes digital printing so creative. In the
traditional darkroom you can see the result of changes only
after processing a print, but digital technology allows you to
experiment in "real time" with every essential printing contro
and try many different variations. Tne contrast and exposure
cantrols will be familiar to racitional garkroom printers, but
they become so much easier o use in the oigital
environment.

INTRODUCTION 1



~white pholography offers many exoressive

elnpment
ing), printing choices, and, of course,

ter make for a versatile, powerful medium. All
of these images are about the interplay of light and
subject matter. By exposing Tor bright highlights |
entuated line and form 'n a building (zbove]. By secing
the possibililies in black and white | ereated 3 granhic
representation of Lorn posters [right) in image processing.
By studying other mediums | transformed & dock piling
{opposite] to an emulation of an abstract exoressianist's

subject Mg

di

Manocnrome st :J'.'i‘\,".
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Finally, a few words about software. Throughout this tions in terminology and tools from Photoshop to the soft-
book [ make references to Adobe Photoshop software, the  ware you use.
lingua franca of the digital darkroom world. My refer- I encourage you to apply all the tools and techniques in
ences are not version specific and should help you to this book to your work. Be aware that with Photoshop and

work easily with whatever the latest manifestation of this ~ many other programs there’s more than one way to reach

incredible software might be when you read this book. If  an effect or goal; stay open to new ideas and methods, and

you have a different type of the many image-editing pro- talk with those who share a passion for printing with you.
grams available, you can still use the techniques described That's how I learned all the techniques here, and how 1
in this book; you will simply have to make the transla- continue to grow in both my study and creative pursulits.

to interpret an image, as long as the interpretation does nal intertere
with the communication—that is, how you want to express a lime, place, or specific subject 'n tones, exposure,

There 's really no right or wrong way

and cantrast values. | scanned this black-and-white negative, then (left to right} produced a close emulation of
what & contacl print might have looked like on a normal photographic paper. | also increased tne contrast, then

increased contrast and exposure, 3nd finally, colorized the image. Yau can easily accomplish variatians like

these using the printing technioues covered in this book,

14 INTRODUCTION
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CHAPTER ONE

s i e e T S R ey S s

AN APPRECIATION OF
BLACK AND WHITE

You may soon discover that

the black-and-white print

expresses your artistic vision Study the Legacy
more than color does. Black The Art and the Craft
and white also has many other

merits, from capturing the
‘ beauty of tonal values to
evoking nostalgia.

17




THE POWER OF BLACK AND WHITE

Blk and wh|t allows us to seeW|thout the dlstractlon of color sowe
can approach the heart of a matter, or of a design, in its purest form.

What is it that makes black-and-white photography such a  a great deal of creative freedom and the opportunity to ex-
compelling visual medium? In terms of pure visual enjoy- press his or her artistic intent in every step of the creation
ment, there is the beauty of the tonal values that so richly  of the image—from the choice of subject matter to expo-
express the play of light and shadow—the shades of gray sure to image processing and printing. To those engaged in
and the deep blacks and bright whites. The tones are ver-  a serious study of, and love for, photography, black and
satile and can represent a stark or subtle ambiance with white is of great importance. And for many who collect
equal impact. For the photographer, black and white offers  photographs, black and white is the medium of choice.

!.I.Y“‘ugn
T"“’T Bmww L

| photegrapned this scene from Hollywood Boulevard 'n Los Angeles on chromogenic black-ana-
white film, an excellent source film for plack-and-white scanning and prinling Lhal has minima’
grain and low inberent contrast, | then scanned the image and printed iLoul on glossy ingjel paper

using & olack-ink-only setting,

18 AN APPRECIATION OF BLACK AND WHITE




You can make prints with certain keys, similar to musical values. & lovi-key print emphasizes
darker values and maod. A hich-key print works with micele and lighter shades of gray in which
highlights are muted and textured, providing an ethereal feel. This image of racks on Torrey Pines
Besch in southern Californiz is in nigh key, with apen shadows,

AN APPRECIATION OF BLACK AND WHITE 19



PHOTOGRAPHIC PRINT

* A successful print communicates the thoughts and feelings

THE BLACK-AND-WHITE

of the photographer at the moment the shutter is snapped.

Often, a print faithfully depicts a scene’s original quality of The ability to enhance the moment, or to reinterpret
light. Or, a print can reinterpret the scene to enhance the the vision, is one of the most exciting aspects of the art
image or to add further visual expression. The photographer  and cralt of photography. This artistic freedom is the key
makes these reinterpretations while exploring the image's to enhanced communication through photography. It can
visual possibilities, finding ways to go beyond what was bring even greater creative forces—introspection and ret-
glimpsed, or intuited, when the shutter was first released. rospection—into play.

This faresl scene, fram a scanned medium-format negative,

was photographed under
Fairly flal (low-contrast] light'ng conditions. By manipulating tre values | was able to
establisn a wisual rhythm of lignt and cark Lones.

20 AN APPRECIATION OF BLACK AND WHITE




Exoressive printing is a persoral approacn that can

nvolve stylistic decisions or simply finding & unique
n this sequence, the
ita camera using

tis,

original exposure, made witn a o

recepntive to creative interpretation. The tonal set is
enhanced by increasing contrast (middle], A more

emotional approach is shown at the bottom, where
freenand docging decreases dens
ncreases density. Your inlerprela

iy to render

/5. | often

makes printmaking so exciling

g scene in 5o many different, perso

seek out such scenes when | photograpn, knowing

they will allow far many interpretive approaches,

AN APPRECIATION OF BLACK AND WHITE
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SAVOR THE NOSTALGIA
Scanners, igital software ols, and rintig techiq
allow us to save a wealth of treasures from the past.

We all know the range of emotions that black-and-white iar news photos and portraits that have become icons of
photographic images evoke. We might enjoy a warm feeling  their age. Affordable scanners make it easy to preserve fad-
of nostalgia when viewing old family photos or classic black-  ing prints and negatives, and digital printers yield prints that
and-white movies, or share a sense of history in seeing famil-  can last as long as their silver and dye counterparts.

Using a scanner and digital retouching tecnnigues, you can
rescue ald images that may have become camagedc andfor
faded. You can ther share [nese precious images ang, more
importan?, pass them an to future generations. My family
velieves thal this is a photograph of my grandfather, «illed
in World War |. | scanned the origing and ¢id some quick
retouching, then created z toned image for framing.

2 AN APPRECIATION OF BLACK AND WHITE




Dig'tal-imaging software var work
miracles. | found this print, so
faded it's about Lo dissonear
altogetner, in an album thal, from
the clathing, seems to be from tne
|zte 1880s or early twentieth
century. | then scanned it 2

used image-editing so
to heighten contrast and enhance
density. As a result, these people

once agair share a happy maoment

in their lives, While tnis picture
awaits more work, the abllity of
scanrers and software to rescue
images from obseurity ar loss is @
greal boan to historl
researchers ana fam'ly
pholographers.

| found this photo depicting a simpler time
and ioyllic place st a fiea market, The criginal
orint was an very thin oaper and might be an
example of a cyanatype, or pernaps it was
just tored blue using a lang-forgotien

chemical mix. After scanning and retouching,
and a slighl alteration in image color, the
picture can be zppreciated a hundred years
From o

AN APPRECIATION OF BLACK AND WHITE 23



STUDY THE LEGACY

Jo=sE s e e e R e e R T B E e

et R
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One of the best ways to understand what makes a
print effective is to study the work of the masters.

Photographers, printmakers, and other artists may well
have inspired vou to pick up a camera, or brush, or a stick
of charcoal in the first place. | draw much of my inspira-
tion from diverse artists—from the Photo-Secessionists, a
group founded in 1902, 1o moedernists such as Paul
Strand, Aaron Siskind, and Minor White. I also am in-
spired by the monochrome studies of Edward Hopper and
the etchings of Rembrandt, which I first viewed in some
dim museum gallery when | was young. Digital mono-
chrome printing, the subject of this book, draws upon vi-
sual references that include all the visual arts. There’s as
much to learn from studying seventeenth-century Dulch
etchings, nineteenth-century Japanese woodblock prints,
or alternative photographic processes such as platinum
prints, gum bichromate prints, and even daguerreotypes
as there is from looking at modern digital prints.

24 AN APPRECIATION OF BLACK AND WHITE

As you get involved in your own work, make time to
oo to museums and gallery shows, and seek out work you
admire. If a print grabs you, try to understand what about
it makes you stop and study. Of course, the subject matter
is importanlt, bul also ohserve how Lhe crallsperson has
used printing technique as an essential part of the overall
communication of the image.

Though books of collections and monographs are great
ways o get to know the works of a number of different
artists, nothing quite matches the impact of having an ac-
tual print in front of you. Regardless of how well the book
is printled, there’s always a generation gap between the
“live” print and the printed page. Il you've ever stood be-
fore a real Rembrandl, a Raphael, a Paul Strand, or a
(George Tice and compared the work to how the image
appears in a book or catalog, you know what I mean.

AR




~riece okl | mindy ) SORETReN | R

. and now-extinet photographic
3 grand old mosgque in
bumen orint;

ol prints, grephic
rechnigues. This image
[stanbul coult be a nineteenth-century &l
however, | made it with a digital camera lasl year and
printed Tt with an inkjet printer.

Similarly, the photo of New York Tn winter an the
opposite page references the tonal and image calar
rendition of & Photo-Secessionist print [rom the turn
of the nineteenth century.

3pny allows you 1o re-create the look of

WHAT TO LOOK FOR IN A PRINT

Look at how the tonal scale (from white through the grayscale
to black) is handled and consider whether high or low contrast
is important. See how the edges are handled. Is there a strong,
centered play of light, or is there a diffuse feel to the image?
How are details in the highlight and shadow areas handled, and
does this add to the impact of the scene? Is the light play real,
or is there a tricky, experimental vision at play? Does the overall
texture of the image play a role (the smoothness or the rough
quality of the grain, or "naise")? And how does the type of
photographic paper itself influence your impression?

AN APPRECIATION OF BLACK AND WHITE
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THE ART AND THE CRAFT

‘Art and craft are délicétély'b'alanced in ev'e'ry slif'age o'f”creating
a black-and-white image. Your goal is to produce images that
will touch the viewer and express your artistic vision.

By definition, art seeks to evoke response and to communi
cate ideas and [eelings through creativity; craft refers to the
techniques that make for effective art. Printing technique,
part of the craft of photography, serves your expression—
your vision and the image created from thal vision. You

create a digital print by laying down ink on paper to create
an image. Digital technology can enhance your artistic abili-
ties, because digital techniques allow you to emulate the
look of any process, old or new, wilh relatve ease.

Wnen you first ooen a cigits -imaaoe file you should
take some Time to cansiaer where y
This scene [left) needed some

U want it to go.
adjustment, but

could grasp its potential only atter | too« the frst
step and enhanced tne tanal relationships. This

became a saringboare for ather aptiors, here an
expansion of the cloud reflection through use of the
clone (Rubber Stamp) too

nd a unification of the
valles of the sky and an overall contrast adjustment,




< Tnere's 8 long tradition of applying or
adding coor to manochrome images, &
tecnnigue made easy in the digita
darkroom. | converled this photo of an
antiques store display from grayscsle
[nlack-and-white] to RGE [eolar] mode
and added a sepia tone using the
Wariations oo

¥ To lend the look of an old, faded
posteard to this rural scene | waorked
with painting tools and chose varicus
color opacities, again with the grayscale

AN APPRECIATION OF BLACK AND WHITE 27



Black and white is 3 bit of a misnomer, as many
manacchrome images can be just as eTective
when imbued with an oversll color tone.

Chemical toning has a time-honared tradition
within this craft, ranging from the deep blue of
cyanotype to the nostalgic feel of sepiz or
brawn loning. Tne aigital darkroom allows you
to explore many different toning possibilities,
all with ease. This photograph of & high-
mountzin lake in Montana has been printed
with 2 lignt, warm-brown tone (above] and
with a cool blue color cast. Each photo will
henefit from its own color-toning approsch,
deperding on how you want 1o interprel the

image.

28 AN APPRECIATION OF BLACK AND WHITE




THE ARTIST AND THE CRAFTSPERSON
Digital photography is not like snapshot photography, in
which picture-taking is the end of the process for the pho-
tographer. With digital photography you can make your
oWn prints to express your artistic vision, to capture the
character of the image, and to convey the fun and excite-
ment of the work.

An important part of making good black-and-white
prints is understanding what goes into an effective
print—for you. Before you can take that personal journey

vou must understand the power of the black-and-white
medium and grasp the terms and visual associations that
make black and white work. You have to understand
what, In your eyes, makes a print effective. You will come
to understand how printing affects the way in which a
photographic subject is seen and to appreciate the cre-
ative choices you have as photographer. As you begin to
create images, you’ll see how deliberate choices and an
educated intuition will have an important effect on the vi-
sual and emotional impression that each image makes.

Look Tor the picture within the picture, then
experiment witn patierns, tones, and cropping.
| cropped this simple shot of two flowers in g
fie'd to one flower, and after some contrast
adjustment repeated Lhe pattern using the
clone tool in various opacities,

AN APPRECIATION OF BLACK AND WHITE 29
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Each ol these orints was originally photographed with a dig'tal camera
se1in RGEB mode. In digital, converting fram color to black and white is
fquite simple, with numerous paths available, depending on the deg
contral you desire. This ease of conversion mears that you can
phetograph with the intention ef working ir monocnrome, even though
you record In color, or you can work with coior slices and negatives you
may have pho? 1 Lhe past and revisit them as black and white,
In addition, when you are working with monochrome imaages in the
computer you can view and work on ther in RGB maode, This makes it
simple to add calor tane or Lo selectively add color, mutet
rt of the image you desire. The flexibility means that

ee of

graphes

bold, to

Jcan nring

east

ve cantrols 1o your arinting Lhat in the past were al o
labarious ara often impossible Lo attain,

AN APPRECIATION OF BLACK AND WHITE
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CHAPTER TWO

OF A BLACK-AND-
WHITE PRINT

There is no right or wrong way to
make a print, but understanding
how a print works and what to
aim for will make you a better
printer and ultimately a better
photographer in the bargain.

33



TONAL 5CALE

creates shadows and h|ghi|ght5
and lends a photographic image its emotional value.

Photographic images are distinguished by the illusion of
continuous tone, the creation of an image through the
use of black, grays, and white that flow through what you
could call a grayscale spectrum. Of course, not all black-
and-white photographic images display a full tonal range.
For their emotional power they might rely instead on an
emphasis on deep tones (dark grays and blacks, or low-
key images| or high tones [lighter grays and whites, or
nigh-key images), or even just black and white, with few
or no gray tones at all. They may also be toned or have a
decidedly brown, sepia, or magenta color cast. Some may
even have a dash of color thrown in.

The range of tones that are reproduced in a print is re-
ferred to as tonal scale. Tones are the blacks, whites, and
shades of gray that are available in black-and-white image
making. You can’t create tones that don't exist on a nega-
tive or in an image recorded by the digital sensor, so you
want to record as full a range of these tones as possible
when vou take a picture.

When you make an exposute you are recording the
brightness values that exist in the scene. Bright areas are
called highlights and darker areas are called shadows.

& common complaint sbout digital
arints s tnat tney cannot reproduce
the values seen in a silver print. |
respecttully disagree. This digita: pring,
made from a scanned 35mm black-
and-white negative, yields a tana
range ana variely that | would oe more
than happy to ebtair from a siver
print.

34 THE ELEMENTS OF A BLACK-AND-WHITE PRINT

Two terms to keep in mind are significant highlight values
and significant shadow values. Significant highlight values
refer to the brightest areas in the scene that contain tex-
ture [as opposed to spectral highlights, which are glints of
light, like those sparkling on a pond in the late afternoon).
Significant shadow values refer to the darker areas in
which detail or image information appears, and deep
shadows are deep tones without detail, like the shadows
cast on a bright day.

Of course, your photo contains more than just bright
and dark areas: A whole range, or scale, of tonal values
goes from near-black to near-white, with myriad possibili-
ties in berween. Some photographers differentiate these
shadings into eleven zones, numbered O through 10 (with
0 being pure black and 10 being pure white|. In digital,
the generally accepted tonal grayscale is composed of 256
levels. Most importantly, the tonal scale recorded during
an exposure defines the range of possibilities within the
print. If you have recorded a broad scale of tones, you can
generate a broader range of tones on the print, or at the
very least, produce a better print than you could if fewer
tonal values were recorded.




The cholce o tones has & profound influence on how the image anc the subject are perceived. [n some

cases ol will want to have as Tull 2 tonal range as possible, in essence, malching the lignt values of the
ariginal scene. This print of a high desert scene contains a range of tonal values, from textura! highlignt

Lo deep shadow. | gimed the enhancement techniques at mantaining the toral values rather than
interpreting them by making shadows deeper ane hignlights orighter and @ tering tne gray values that
zpoeared in the original scene.

THE ELEMENTS OF A BLACK-AND-WHITE PRINT
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Knowing that you perform contrast adjustments witn ease In the digital

darkroom can guide you 'n making exposure readings. If contrast is not

too excessive, make your reacings Lo include as much of the tona! range

as passinle. | pholographed this scene with a digital camera witn [ne

U VD NS Sy Sp—. . expusure lack on the -mado-{-.- _areasﬂand cxposurrz: r_'r.:nﬁpensstion at -1.
LS RS, P e e ke result a very good rendition of the shadow detzil in the scene.

might wani to say in your image. | made lhis gnote in tng Bist' Bad'ands

In New Mexico urcer sunny midday conditions. The slarc white

nighlignis, deep shadows, and deep gray background nelp communicate

tre harsh laroscape by exploit ng every possible tone.

» Spectral highlights, like the glare off this pond,
can produce Tare, 2 ghosting that can cause
unwanted effects in other parts of the image, Ore
af the keys to controlling spectral hignlights is Lo
contan them wilhin areas of darker tone,
Darkening the image in the ecit and manipulation
slage heps, s does same extra burning and
dodging around the highlight to <een It contained.
Try Lo avold composing witn spectral highlights at
{ne ecges of your image, as they will be harder Lo
separate Trom tne paper white al the print borders.

36 THE ELEMENTS OF A BLACK-AND-WHITE PRINT




COMPRESSED TONES

Brightness values in a scene can become mured even if
you expose correctly. Usually, this problem results from
flattening, or compressing, the potential tonal scale in
scanning or printing. To use a musical metaphor, if you
record a concert on a hand-held tape recorder hoping to
re-create the sound of the full orchestra, you'll be disap-
pointed when vou play it back. The loss of fidelity in vour
recording may flatten the bass notes and mute the treble
notes; flutes may become shrill, while the distinction be-
tween the bass fiddle and tuba may be lost and come out
like a deep “blah” sound.

In visual terms, the highlights may all merge into a
harsh white, and the shadow, or deep tonal separation,
may lump into a dark mass. You may even compress the
tonal scale so much that all the tones come out in a gray
mass, with little or no distinction between them. Some
loss Is inevitable when vou translate a recorded image to
a print. You'll witness some loss in the mere recording of
the scene—for instance, the brightness value range might
exceed the recording capabilities of the film or sensor. In

addition, all photographic media see somewhat differently
than the eye does, and may indeed be blind to some tonal
separations in the original scene. Visually, we see the
image on the screen as being backlit and the image on the
print as reflected light, which alone accounts for some of
the loss. Technology, too, has an effect: [n some cases we
might record or scan at 16-bit and have to edit and print
al 8-bit. But even with some of these built-in hindrances,
you can learn how to work through or around limitations.
Once you do, you'll begin to see how the fullest possible
tonal scale can be recorded and eventually brought to
play in the print.

When you get into the digital darkroom and make a
print, you can enhance or correct tonal values in many
ways. You can make selective areas within the scene
lighter or darker, or increase or lessen contrast. Making
selective areas darker, or bringing down values, is called
burning; making certain areas lighter, or opening them
up, is called dodging. The great many ways you can con-
trol, enhance, and even correct tonal variety is in large
part the subject of this book.
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CONTRAST

i

light and the subjects in the scene.

Contrast is the relationship between light and dark tones
in an image—that is, the relationship between the high-
lights and shadows. On bright days with deep black shad-
ows we have fairly high contrast. On overcast days with
no shadows we have low contrast.

Contrast is not just determined by the overall light
value. The range of subjects and their reflectance within
the scene has a profound effect on contrast as well. For
example, if we have one bright, shiny object within an
overall “flat” lighting situation, we may have a high-con-
trast situation, just as we may have low contrast on a
bright day in a snowy fleld.

We measure the brightest and darkest parts of the
scene with a light meter, and derive the contrast reading
from the difference. The difference between the brightest
and darkest parts of the scene is measured as Lxposure
Value, known simply as EV, a combination of aperture
and shutter speed with which a photographer can mea-
sure contrast and adjust the settings to get the best possi-
ble picture.

& print can commuricate Lhe character of the
ambient light, and even the time of day anc
wemperature of the airl | photographed this
abarconed shack in the deserl in the middle of
the summer, witn the light shimmering all
around. Empnasizing the brighter values
communicates the feeling of the marment tnal
the image was made. Molice that | ook care Lo
maintain texture in even the brightest nighlighl
values, keeping them as significant highlignts.
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Contrast is the visual play between the ambient

Often, you can correct or enhance contrasl in an image
to add visual impact. There are many ways to manipulate
contrast: You can take corrective steps to add tonality to a
blank or overcast sky, make up for underexposure in a
high-contrast scene, or tone down highlights that have
scant texture or surface detail. To enhance contrast for
creative purposes, vou can change the relationship of
dark-to-light values—vou can add more contrast to en-
hance an abstract view of a city, for instance, or you can
mute the contrast to enhance a bucolic nature scene.

[n digital printing, as in silver printing, the main enemy
is excessive contrast. This occurs when a loss of shadow
dertail and overly bright highlights create a harsh, texture-
less look. In silver printing you can, to an extent, control
this by burning through the density and creating some
tone on the print (even though you cannot retrieve lost
highlight detail}. In digital printing you do not fog high-
lights through exposure—you have to get some ink down
on the paper to create density {a value below paper
white| on the prinL.




| made this ohotograph [lef) with
a red filter over the lens on 35mm
black-and-white negalive film.
While tnis tecnnigue noosted
cantrast snd deepened the olue
sky it resulled in excessive overall
contrast and it took ouite a bil of
work 1o bring tais narsh cantrast
under contral. My advice s to
avold using such contrast fillers
an your camera (film or gigital]
and make desired contrast
cnanaes in tne digital darkroom,
Just about the anly filzer [ keep in
my camerz bag these days isa
polarizer, The image below
resulted from lowering contrast
Jsing Select'an toals and Levels
controls,
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Printing tecrnigues &l
values to enharce ¢
faur primsry
tonal range as possiole, and then consider

ad censity enbancements

5 is, with a

s ective contras
ater. The scene gt right seems fine
good rarge of light to dars tong values. After |
"brought down” (made dar<er) the backgraunc
values, ho the trees and brancnes in tne
foregrour

sop maore gnd the rendition is
much maore effecti

Lul
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This scene was made in ceeo-Torest gt
resulting in & fairly ©at, cark image (top).
Tne first step 0 enhancing the scene was to
“oper up" the exposure oy abous 3 stop,
easily done within the Raw image processor
or through the use of Sereen Blending
mode [center). To increase contrast
somewhat, | useo the Burn tool in selactive
parts of the image [bottom], This crested a
mare dynamic image witn & full range of
tanal values—how the supiect was seen, not
necessarily how 't was Trst recoraed,
Frintmaking is enhancing and (nterpreting
photographs in ways that serve your
crestive visual instinets ano desires,
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Selective cantrol of lonal
values equals contrast
adjustment. In this oholograpn
| took in the Malpais area of
central New Mexico, | made
tne dar<er values deeper Lo
raise the perception of
orightness in the lignter zreas,
which were untouched. Often,

raising or lowering sxposure of
ane walue will change the
averall feeing of the image.

S maolicity in appre
make enkancement af 30

F can

image an easy affair.
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This photagraph (1) was made fram & scarned 35mm
negative. Because of the high contrast, | exoased for the
snadow cetail anc developed the negative for 20 percent
ess than normal, out the nighlights remainec quite harsh,
After scanning, | oarkened the entire image using &n
Adjustment Leyer with Multiply Blending mode, which
darkened the high'ight areas without increasing overall
cantrast (2], | then used a Layer Mask/Paintbrush tool to
"cut pack” to the original shadow values, keeping the
highlights untoucned (3] | added a touch more density to
the highlignts with the Burr tool [Highlighls{18% Exposure)
on a Duplicate Layer (4], 1 then added grain Lo the entire
image o help unify e values, using the Noise=Ada Moise
flter (5],
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EXPOSURE

NI S o D S R e S e I e e

Sthtter speed and aperturevaluedetermmethe qué'htity of

light in an image. Digital technology gives you an enormous
amount of creativity in working with these values.

In digital camera recording, an address identified by binary
code signifies the density in the image. Each pixel contains
information about the relative brightness of Lhe light, which
in turn is read by the image-editing software. When you
work digitally you are using software to read out a series of
codes that emulate the density you see on the screen and
subsequently the density of the ink on the print. In essence,
you turn a virtual image into ink on paper.

When you work with film, during exposure the degree
of change of silver halides is proportionate to the amount
of light energy that strikes them. Thus, brighter light cre-
ates a greater change in silver halides, which, during the
development process deposits more metallic silver on the
film; dimmer light results in less change, thus fewer de-
posits. This deposit is referred to as density, and this den-
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sity translates into darker and lighter tones in the nega-
tive, which mirror, in reverse, the brighter and darker
areas within the scene.

One of the major differences between film and digital
photography is the way the image is read and how you
use code rather than negative density to re-create bright-
ness values on prints. kach pixel contains the exposure
DNA, if you will (and in the relationship of those millions
of pixel addresses, the scene contrast|. As a result, you
have an incredible amount of control over that image. In
fact, you can alter the values of exposure and contrast in
an almost pixel-by-pixel manner. You have the flexibility
to make prints that emulate, as much as possible, the val-
ues in the original scene or to alter them in just about any
way you desire.




When photographing, a good rule of thumo is to "follow the light” and enhance that ight when
manipulating tne image later. This palm frond was backlit, but | exposed to get as much shadow
detail as possibie. This gave me numerous options. | cnose to go dark Lo enhance the backlil effect,

<l This photograoh was made using an inlrareo-
adapted digital SLR. When printing, | dign’t want
to lase the infrarea effect, which meant that the
lighter wvalues should remain ethereal. | "burned
dowr" [made carker] the surrounding areas Lo
enhance the lighter aress even more.
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TONAL CONSISTENCY

A photographic print has a certa{n 'lhythm —a ﬂ'ow oftonallty,
exposure, and contrast that creates a cohesive image.

[f you open the shadows but burn up highlights, you lose
the flow of an image. If the direction of light is obvious
but light from another unexplained source intrudes, the
eve will reject the scenario. In addition to paying atten-
tion to this rhythm as it naturally occurs, you should also
consider certain fricks of the printing trade that help aug:
ment the rhythm. Consider, for instance, the direction of
light within and though a print. The story goes that the
film director Eric von Stroheim always lit Marlene Diet-
rich brighter than any other person or part of the scene.

Apparently, von Stroheim would have one lighting techni-

cian follow her throughout the scene, always throwing
light on her face and form. This created a glow that be-
came part of her screen legend.

The point is, you should pay attention to how light is

handled within a scene and how you can exploit it to add

subtle emphasis to your main subject. This becomes clear
in portraiture, where you always want to make sure the
subject’s face is brighter than the surroundings. The
brightness both focuses the eye and creates a dimensional

feeling of space and volume. You can apply the same prin-

ciple to scenics, close-ups, and abstract studies. Think

This print is all about creating
of light, though you
in't take the term too
While the origingl was
somewhat brighter in the
center than the rest af the
scene, | darkened the cdges
cansiderably to add drama.
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about the location of the light source, the character of the
light, and how you can (reat the surrounding area to add
just a touch of emphasis to the subject you want to en-
hance and draw the viewer’'s eye into the picture.

That brings us to edge-burning, a tried-and-true
printer’s trick for bringing the eye to the “center” of the
print. Edge-burning is a subtle technique in which you
make the edges of the print slightly darker than the main
subject in the scene. In digital photography, you will be
using selection tools and Layer Masks Lo create this effect
in just about any print.

Another trick is to create visual rhythm by carefully
using Burn and Dodge controls in areas with monotonous
blocks of tonal values. You can make these blocks more at-
tractive to the eye and create a source of visual enjoyment.
For example, say you have a field of ferns that is consis-
tently lit and is in the foreground of a deep forest scene.
You can burn down areas, emphasize shadows, and ele-
vate highlights to make the field of ferns even more visu-
ally engaging. This technique is useful in scenes that
include clouds and water, in which blocks of the same
tonal values are likely [o occur, and even in portraits.




One of the ways to creafe more
visual interest in a print is to break
uo large masses of sim'lar tona
wailes, Here the figld of grassesin
the foreground creates a large block
ol fairly harsh walue. To creale some
tonal variety | seectivery hurnec the
foreground (adaing density) to unify
the tonal cansistency of tne entire
orintand eliminate a large,
distracting mass of harsh values.

THE ELEMENTS OF A BLACK-AND-WHITE PRINT 47




The colar ariginal was photographed in apen shade, great for color but often & bit flat
tor black and white, After conversion | considersd many different tonal varialons and
camme up with edge burning, which added dimension to the main subject.
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By selectively altering contrast and exposure in
the scanned photograph on tne | i
emphasis from tne averall scene o ¢
clement witnin the scene. Often, prints ar
about what is not revealed as much as
ana it's part of the creative process Lo iden

the picture within the picture, Photos like this

are ofl
you can visualize the changes as you work, you
unimaginec in the

Can eXpeEriment in
racitional carkroam.

THE ELEMENTS OF A BLACK-AND-WHITE PRINT

49



HIGHLIGHT CONTROL

W|thmd|g|tal techmques you can enhance and control h|ghl|ght5
and inject “snap” into your prints in many ways.

The loss of texture in highlights renders any image harsh ~ unappealing, but fixing that is a much easier matter. Pho-

and unappealing. Proper exposure is the best way Lo tographers who've worked with film in the darkroom

avoid this; you should be especially watchful of overexpo-  might know about using potassium ferricyanide to clear

sure with digital cameras. There are numerous ways 1o highlights, or using selenium toner to snap prints up. For-

correct for this harshness, covered in Chapter Four tunately, digital printers help you achieve similar effects
Dull highlights (flat-looking bright areas) are equally while avoiding these noxious chemicals.

it

Contrast changes can be supte or radical. Here, | allered a poorly exposed image of Twigs in snow
ta represent a pen-and-ink drawing. With digital Lools, you can make changes like this with ease.
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While | usually expase for as much shagow anc highl'cht detail as possible, there zre
times when | see the final print in my head as | take tne gicture. That's the case nere,

where | exposed for the highlight walues, thus ariving the shadow detalls into ceep
tones. | knew | would never want the details in the chair shadows, so my exposure let
them fall where they may. | then orinted as exposed, with wery little madification.
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SHADOW DETAIL
Although a print with deep, dark values is certainly more
acceptable than one with harsh highlights, at times you'll
want to enhance deep shadow values or obtain detail, no
matter how sparse, in the darker tones in a print. Having
stch values and detail can open a print up in ways that
you might not have noticed before. As long as there is de-
tail available in the pixel information, it's fairly easy to
open up shadows.

In all, approaching a print in a fairly rigorous way and
considering the factors [ have outlined above will lead to
a much more satisfying printing experience. It will also
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enhance the print so others can enjoy it to its fullest.
While some people might not quite know why they prefer
certain prints over others, it is usually because of the qual-
ities | have outlined above. Fellow photographers—and
especially printmakers—will understand what you have
achieved and they’ll give you a knowing, appreciative nod
when they look at your work.

Throughout this book I'll refer to these print attributes
and give you the tools to realize the fullest potential of
every subject and scene. Once you have the tools in hand
it's up to you to apply them as you wish.




ke R

A Tne dynamic range of film can be guite impressive, especially when sxposure and development is
coordinated. Here a wide range of values is recorded by reading the shadow area and reducing exposure
from that reading by two stops and development by 20 percent. To keep Lhe shadows open [readable details
and texture] and to subdue the highlights in this scan of the negative, | used a Levels Adjustment Layer with
& Multiply Blending mode. After that | masked back the shadows ta their original [scanned) values.

<l Becsuse you can alter cach pixel address in a digital image, your ability to play with images is limited
nation. In this exposure of the base of an uprooted tree, burn and dodge lechinigues
emerge from the tangle of shapes and values.

anly by your ima
caused new forms to
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CHAPTER THREE

THE RIGHT
EQUIPMENT

Producing a black-and-white
digital print begins with
making the right decisions
when getting an image into
digital form. Then comes the
challenge of successfully
reproducing the image onto

paper.
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FILM AND DIGITAL SOURCES

~ FOR DIGITAL IMAGE FILES

An |mage must be in digital form so you can Work Oﬂhlt ' How you

digitize the image doesn’t matter. What does matter is that you
pay attention to some of the unique challenges that digital
photography presents.

The digital format requires that you perform specific tasks
that might be new to you and that clearly differentiate

di
m
th

gital from film. For example, both film and digital prints
ade for the gallery wall should be printed differently
an they would be if used as illustrations in a newspaper.

In addition, an image intended for use as a large print
needs to be set up differently than it does when used [or a

W

eb page or e-mail attachment. Making the right choices

up front will make your task so much easier later. You will
live and learn, but be aware that certain missteps will del-

in
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itely impede your progress.
Here's an overview of some of those considerations.

The first step is making an exposure in the camera—>be
it film or digital—that will faithfully render the bright-
ness values in the original scene, and that will result in
an image that is “easy” to print. While automatic-expo-
sure cameras have made this considerably less of a chal-
lenge, there are certain lighting conditions and subjects
that can cause problems. Reading the light in the scene,
and making judgments about how that light best trans-
lates to film or digital sensor, is one of the most critical
aspects of photography. While remedial steps can be
made to correct exposure errors, a badly exposed image

THE RIGHT EQUIPMENT

can cause major headaches in printing. The challenge is
to balance the sensitivity of the recording medium with
the light values and to do so in a way that yields an
equivalent range of those light values on the film or on
the sensor that sends that information through the
image processor to the memory card.

The second step is getring the image into digital form. If
you photograph with a digital camera you've already ac-
complished this step. You need to be aware, however,
that how you set up the camera—especially with the
proper resolution and file format—is key to making the
kind of prints you want. If you are working from film
images—color or black-and-white negatives, slides, or
prints—you’ll need to digitize them by scanning them
or having someone scan them for you.

The final step is making prints, which involves creative
decisions about how the light originally captured is to
be rendered by ink onto paper. This brings into play
matters such as proper monitor calibration, paper profil-
ing, and using techniques to get a digitized image ready
for continuous-tone printing.
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& digital image is composed of pixels. These
picture-bullding blocks each have a distinct
address that includes information on
brightness, contrast, and color. Your ability
change cach adoress means you nave
incredible control over every aspect of the
image. To wisualize these pixels, open up an
image and keep hitting the Zoom ool AL one
pairt the illusion of continuaus wone bregks
down anc the pixels are revealed. Here's a close
look at pixels ina tonally ricn image with
increasing magnification.
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DIGITAL CAMERAS

D|g|tal carﬁerasrangefrom snnpl@ '[;‘:)oint"-énd'-shoot modelsl‘to hzgh
resolution backs and SLRs. With the right techniques, you can
optimize every picture you make with just about any digital camera.

SENSOR SIZE AND MEGAPIXELS

Obviously, if you already shoot with a digital camera you
are ahead of the game when it comes to making digital
prints. But ['would like to insert a note of caution about
digital cameras. While some can match and even exceed
the quality of film cameras, not every digital camera will
give you the high-quality prints you can get if you scan
from well-exposed and properly focused film images. This
is especially true if you photograph in film formats larger
than 35mm.

One of the keys to getting good images to print is sensor

size, defined as the megapixel count. The megapixel count
of the sensor determines the size of the print that can be
produced from the digital file. Mega means “millions™ and
refers to the number of photo sites—or light and image-
gathering points—on the sensor. In general, if you would
like to make good prints as large as 8x10 inches vou will
need at least a 4-megapixel camera. If you want to make

3

FILE SIZE AND PRINT SIZE

While each image has a certain resolution leeway, there are ballpark figures that
allow you to predict fairly well how file size can affect print quality. You can get
a decent 8x10 inch print from a 3-megapixel camera, but you are usually better
off with a 4- to 5-megapixel camera. For sizes up to 5x7 inches, a 2- to 3-

larger prints—or get the best quality in your 8x10 inch
prints—then a camera with a mexapixel count of 5, 6, or
greater is recommended. Of course, megapixels are not
the only components of image quality. The lens and the
camera’s image processor have an effect, too; indeed, ['ve
worked with 4- and 5-megapixel cameras that don't pro-
vide the quality of a single-use film camera.

The size of image file your camera can produce deter-
mines the size of the print you can make from it. For ex-
ample, an 8x10 inch print will reguire, at a minimum, a
10-12 MB image file. To find out how “large” vour image
files can be from vour digital camera, simply multiply the
megapixel count by 3. This assumes that you are pho-
tographing with the largest pixel resolution your camera’s
sensor can deliver. If you want larger file sizes—which
yvou might for making 13x19 inch prints or larger—then
you will need to use a digital camera with as high a
megapixel count as you can get.

~ megapixel camera will do fine, albeit with some loss of sharpness and tonal
| separation. | use the figures shown here when | select an image size, when | make
| my own film scans, or when | set up my digital camera. Note that you can use

smaller file sizes in some instances and even resample up the size a bit for bigger
prints. In other words, there's what you could call a "fudge factor" in all this.

Note also that | give these figures for 8-bit images.

File Size RGB (or file size Megapixel
Print Size (inches) you input when scanning) Count of Camera
16x20 and up 72 MB and up 24 MP
11x14 to 16x20 and up 42 MB and up 14 MP and up f
| 8x10 to 11x14 and up 18 MB and up 6 MP !
. 5x7 to 8x10 and up 12 MB and up 4 MP
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One of the key compenents of image quality is
the resalution setting on your digital camers or
scanner. Quality begins to deteriorate the
[urther away you get from the resolution/
enlargement "safety zone." Tnis photograph
was scanned at three different resolutions—onc
at 300 dpi, one at 150 dpi, and one at 72 dpi,
then enlarged to 828 inches. Note how the
guality, snarpness, and detall deleriorate as the
dol gets lower. You get a similar effect if you
snoot 2t too low a resolution in your digital
camera or fall to change the resolution setting

in tne Image Size d'alog box in your image-
editing software,
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FILE FORMATS AND RESOLUTION is a way for the system to gather more images on a given

WHEN USING YOUR DIGITAL CAMERA capacity memory card, but it tosses away information
You have a number of options when making photographs when it writes to the card and replaces that information
with your digital camera. Here are some guidelines that with mathematical formulas, not raw image data. Don't
will help ensure that you get the best possible images. tweak the image in the camera with contrast or sharp-

ness settings. These are fine for special effects in the
camera, but you can do a better job later when working
with software in the digital darkroom. Finally, don’t use
digital zoom. This actually crops into the sensor area, re-
ducing the resolution and the resultant image file size.
My advice is to walk closer, get a longer-range zoom if
necessary, or crop later in the computer.

» [f you have a digital camera that only allows you to pho-
tograph in JPEG format, choose the largest file size you
can get. If you have a choice of various pixel resolutions,
choose the largest as well. For example, if the choice is
between 6402480, 1280x060, or 2560x% 1920, choose
2560x1920. This will ensure that you capture all the in-
formation the sensor is able to record. Also, choose the

lowest compression ratio. If, for example, you have a e [fyou have a camera that allows you Lo choose between
choice between Super Fine, Fine, and Normal, or some JPEG and TITT format, choose TIFF and also choose the
such naming scherme, choose Super Fine. Compression highest possible resolution in TIFF format. This will eat

The ‘argest print | car get fram this image, which | made with a 3-megapixel digital camera, is
Rx7, ana cven that's pushing it a bit, When photographing with s digital camera, keep your
expectations in lire with the resalution at which you make the image. Some image-processing
nrograms do a good job of resamaling, or manufacturing image information, but this rarely

matches the arigiral data. Toa much resampling deteriorates image quality.
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Lens
16.0 - 35.0 mm
Focal Length
34.0 mm
Image Size

307242048
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o

Raw is becoming the digita -

camera Tormat of choice because
of its customization features, but
it does require more work on your

part, In effect, you defer image
processing from the camerz to

computer, Raw is superiar to JPEG
pecause it maintains gl cata, and

o TIFF because il takes up less
data space on your memaory ca

ani hara drive. Tne screen shot

above shows a series of Raw
images in the Canon seftware
browser. The other screen shat

shows an early version of the Raw

Utility with lhe exposure

compensation feature activated. |
sovise using Raw Tar phatographs
that you might want to enlarge

beyond snapshot size later.
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up more space on your memory card, but the TIFF for-
mart does not toss out image information [compress the
image| when it records on the card. Get larger-capacity
memory cards or have extra cards ready when you go
out to photograph. If memory runs low in the middle of
a shooting session, switch to JPEG.

e [ you have a camera that allows you to choose between
JPEG, TIFE and Raw format, choose Raw, Raw files take
up to 40- to 50-percent less memory than TIFF files do,
and the Raw format is subject to less image processing in
the camera. You can use 8-bit or 16-bit depth, as op-
posed to just 8-bit depth captured by using other file for-
mars in most digital cameras. This simply means more

information is captured—in terms of tonality, contrast,
and color richness. The only drawback to Raw is that
you have Lo use special software to work with the files,
though Adobe and other companies are now providing
more options for working with Raw files. Be aware,
however, that when working with Raw files you should
have a lot of RAM and a fairly powerful computer sys-
tem to fully enjoy these expanded ranges. If you have a
choice of pixel resolutions in Raw, choose the highest
pixel count. If you have a choice between 8-bit and 106-
bit recording, choose the higher bit depth. Be aware,
however, that higher bit capture eats up considerably
more space on your memory card and in your computer.

You can make prints from just
about ary imzge, including tnose
vl provaoly wouldn't have
otnerwise shared with the world, |
made this color slide in 1975 on
Kodachrome film. | scanred il
more than a cuarler of a century
ater, converied the image Lo niack
and white, ara did some guick
editing work to fx image flaws
(dust and scratches) and enkance
contrast and toral flow.

THE RIGHT EQUIPMENT 63




SCANNERS

If you’ve ever shot ﬂlm a scanneris an almost essen’nal p|ece
of equipment in your digital darkroom. You’ll probably be
astonished at the quality of detail a scan can deliver.

Flatbed scanners, used to scan prints and film, look and
work like office copy machines. Once the lid is closed a
CCD array passes across the surface and digitizes line by
line. You can use a flatbed scanner for more than paper
prints. 1 have used mine to scan glass negatives, tintypes,
daguerreotypes, and albumen images mounted on card-
board. More expensive flathed scanners come with film
adapters to use for scanning negatives and slides. You can
also use a dedicated film scanner for this purpose, but |
find that a high-quality flatbed scanner with a film adapter
is quite adequate for scanning negatives and slides.

Most scanners offer a choice of working in either
grayscale or RGB [color| mode. | scan all my black-and-
white images in RGB, then convert to black and white
using the Channel Mixer, a software tool that we'll make
good use of in the chapters ahead. Or, [ simply go to
Image>Desaturate to make the conversion. Some new
scanners, though, do an excellent job with grayscale im-
ages. Test your scanner to see which mode works best for
you. Keep in mind, too, that if you are working in
grayscale your image file will be one-third the size of the
same file in RGB. This does not affect overall resolution or
quality. Be aware that some scanners do a better job in

A oscanneris an essential toalin
the aigital darkroom. Flatoed
scanners are especially handy,
zuse they gllow you Lo
revive old prints from tne
family album or make copie

bec

pnotographic materials thal
right oe difficult to manipuiate
even in a traditio r“dl darkroom. |
placed this glass-p k
fram around 1 (
scanner ano backed il with an
opaque, smooth she L\| white
orinting oaper to get 3
that allowed me to mdk’:‘ ar
excellent 11x14 print.
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RGB and fall down in the grayscale mode, and some
don’t offer grayscale mode at all. Check the specs before
you huy.

SCANNER SOFTWARE AND IMAGE ADJUSTMENTS
[ am usually amazed at the detail my scanners deliver, espe-
cially when | compare the image on the screen to a print |
may have made previously in the darkroom. A number of
other printmakers have reported the same amazement. The
scanner seems to “dig” into the film to reveal detail and
rich tonality that you might only see when viewing the film
on a light box through a high-powered loupe.

If a print or negative from which you are making a
scan is problematic—is underexposed or scratched, for in-
stance, or some highlights are burned up or areas are
faded—you can use software that comes with the scanner
to fix some of the problems before you import the image
to your computer and your image-editing software.
Whether you make major adjustments in the scanner, and
how much adjustment you should make, is a matter of
debate. I try to strike a balance and make some minor ad-
justments in the scanner software and the rest in the
imaging software.
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WHICH YIELDS THE BEST PRINTS:
SCANNED FILM OR QUALITY DIGITAL CAMERA CAPTURE?

As more affordable digital cameras offer higher resolution, the debate about which vields the best i
| results for prints continues. In my first book on this subject, done about seven years ago, | decidedly
came down on the side of scanned film. In this book, and in my printing today, | am much less certain
of that stance. | still continue to mine my film archives for printing, which accounts for much of my
scanning work today. And | still shoot film. But more and more I'm finding that | choose to print with
images captured directly from a digital camera.

Of course, there's more to image guality than just its megapixel count, just as film quality results
from proper exposure, development, choice of lens, etc. Indeed, both mediums rely on the skill of the .
photographer and how he or she nuances light and exposure, as well as the point of view when the |
picture is made. !

If you want to work from film but don't want to or can't invest in a good scanner, there are plenty |
of labs that can perform the scans for you. But just as with film labs, scanning labs range from good ||
to bad. My advice is to test a scanning facility with a range of film types and exposures and make
sure that the service does a good job before you commit a large body of work to it.

Whether vou work airectly from a cigital
merg or scan from film ar prints,

vou'll get the best results when you get
as much visual information—tones and

(

delails—as you can in the image e, You
can make the image lgnter ar darker or
increase contrast later. This poture was
printed without any irterpretation and
malches closely the erigingl wnal values
ir the scene. Praperly scanned or
exposed digital image liles will make your
work much easier.
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To g cortain extent, you can adjust Tor exposure mistakes when
scanning, or co il later with the technicues we cover in Chapter
Four. Here's a simple example, Tne simulated negative sbove is
clearly underexposed. 1T a orint were made witnout carreclion,
you'd get the result shown at the twp of the opposite page.
Histogram, right, tells the tale, Even though the shadow are
are clipped, the main loss is in the high'ight areas. A simole
shift of tne white point (the Lriangle at the right side of the
grapn) results in a better rendition. It raises conlrast withour
furtner (oss of shacow dezail, The abil'ty to raise one part of the
contrast scale [the hignlights) without simultanecusly doing
the same Lo the shacaow aress differentiates this approacn from
working with a higher-contrasl grade in the dareroom.
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SCANNER NUMBERS

Resolution refers to the number of pixels per inch (ppi) in
an image. More pixels mean more image information and
the ability to make a larger print that will show detail and
subtle tonal information—that is, to have better resolu-
tion (see page 58). Resolution is a relational number in
that it exists in conjunction with a certain image size. A
1-inch by 1-inch image at a resolution of 80 ppi (pixels
per inch) has 6400 (80 times 80) pixels. The same image
at 200 ppi has 40,000 {200 times 200) pixels.

Your scanner might allow you to scan in 8-bit, 16-bit, or
other bit-depth modes. As I've mentioned, using a higher bit
mode yields more image information but requires a much
larger file size. Some software programs [such as the recent
versions of Photoshop) provide many more editing options
when working with 16-bit files. If you have the processing
power and can work on these 16-bit files in your software
program, consider scanning in the higher bit mode. Even if
you have to compress the image information later you'll
have more image information with which to work.

SCANNER OPTIONS

Just as you choose a certain setup for making images in
your digital camera, you have to “tell” the scanner what
resolution you want it to scan the film or print. Today’s
scanner software makes choosing resolution easy and will
usually determine resolution for you after prompting you
to provide information about what you want to do with
the image, at least in terms of print size (or “output,” as
the computer world calls it). You might also be asked
about the type of material you are scanning. My scanner
has “profiles” built in for many different types of film
emulsions. This can be maddening, because I don't al-
ways know which version of a certain chrome or negative
film I am working with, since there may have been varia-
tions in film stock that can change results. [ try to find the
most generic profile. Learning to input the correct infor-
mation is all part of the trial and error of working with
this equipment. (If you do not receive these prompts you
are probably working in the “Auto,” or default, mode; al-
ways switch to the Custom or Advanced mode and scan
using the settings you input.)

Here are some of the standard choices you might have to make when scanning.

Desired output, file size, or resolution: Output just means the image file size.

. Follow the chart on page 58 for making prints of a certain size. In most cases you

. can type in the desired file size and the scanner will do the rest of the
. calculations for you. Note the “optical resolution” of the scanner—that's the
largest size at which you should work. If you see a figure that has "interpolated |

resolution” or "resampled resolution,” try to avoid it. Knowing the optical

resolution of a scanner, and the file sizes it can create from the film you work
with, should be an important part of your purchasing decision. If you want to
make 11x14 inch prints, for example, make sure that the scanner can get you at
least a 36 MB file from your film.

Image size or percentage: If you scan in a 35mm slide at 100 percent you will get
a 1x1.5-inch size scan, the size of the frame. To make a scan for an 8x10 print you
have to increase the size of the scan to greater than a 100-percent reproduction.
In most cases you will be prompted to input the size of the print you want to
make and the scanner will calculate the percentage you need for the scan.

Output dpi: Dpi means dots per inch, and refers to the printer resolution. If you

are working with an inkjet printer a very safe bet is 300 dpi, although an input of
240 dpi can often work just as well. For example, when | get queries about how
to submit electronic image files for publication in a magazine, | use 8x10 at 300

dpi as a standard.
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WHEN TO CHANGE THE SCAN SETTINGS

If you are getting poor scans, you will want to change the
default (factory-supplied| settings on the scanner. Most
likely, you'll want to adjust the tone curve. Practice first,
and see how your preview image in the scan changes as
you move the tone curve around, then how it translates
10 a print.

You might have some problems with very thin film (un-
derexposed and/or underdeveloped) or very thick film
(overexposed and/or overdeveloped|. Thin films often re-
quire an increase in contrast, but this often causes block-
ing of shadow detail and harsh highlights. You can tweak
the contrast in the scanner software if you wish, but don't
overdo it—you can make a much better fix in image-edit-
ing software, It’s better to have a “flat” scan when work-
ing in your image-editing program than one that's been
overcorrected in the scanner software. I your scanner
and software allow multi-sampling—making two scans or
more of the same image—you can correct this better than
from a single scan.

Just as in the chemical darkroom, the negatives most
likely to give printers fits are those that are overly dense.
Not only do they tend to have excess grain, but they also
can scan “gray,” or deliver poor separation between the
tonal values. Some scanners get a “kickback™ of sorts
from this type of negative and don't even get close to de-
livering the proper values. The best bet is to underscan,
or move the tone curve to get a thinner, flatter scan and
wait to correct the problem in image-editing software.

Some scanners have proprietary software for removing
or diminishing excessive grain in a negative or slide. Some
also have software for getting rid of scratches and other
flaws during the scanning process. Test these with your
images and see if they work for you. The flaw-removal
software can save lots of retouching time later. Be aware,
though, that implementing these programs will consider-
ably extend the time it takes to make a scan.

In summary, | prefer a flat, or neutral, scan to one
that's overly corrected. This produces an image that is
quite malleable in the digital darkroom, where there are
infinite controls for exposure and contrast.

IMAGE SOURCES FOR BLACK-
AND-WHITE PRINTING

You might think that black-and-white negatives
and slides are the preferred sources for black-and-
white printing. Remember, once you digitize an
image you can do just about anything with it, so
the distinction you used to make (choosing only
black-and-white film for black-and-white prints) is
no longer necessary. Any image can be used as a
source for black-and-white printing. You can use
black-and-white or color prints, black-and-white
slides and negatives, and color slides and
negatives. Converting color to black and white is
simply a matter of following prompts. You can use
Image>Mode>Grayscale, Image>Mode>
Grayscale>Duotone, Image>Adjust>Desaturate,
Image>Adjust>Hue/Saturation and move the
slider ta 0, or Image>Channel Mixer. My advice is
to scan black-and-white film and prints in RGB
mode, then convert to monochrome later. Your
experiences and experimentation may cause you to
do otherwise, and some scanners perform better in
Grayscale mode than they do in RGB for black-
and-white materials.
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Histogram

— Channel: | Luminosity

Mean: 126.18
StdDev: 61.23
Median: 131

Pixels: 4531384

TS

Level:

Count:

Percentile:
Cache Level: 1

i Channek: [ Luminosity

Mean: 151.03
Std Dev: 63.66
IMedian: 159

Pixals; 4531384

Level:
Count:
Percentile:

Cache Level: 1
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These scans were made from negatives exposed one stop apart, with the
tog image lile and Histogram showing the result of ane stap

underexposure. Mote how the highlight values fall off as they appraach

the white point. Tne bottom Tle snaws @ well-exposed negativefscar.
Wary digital cameras now have a built-in Histogram that allows you to
review Lhe exposure after the fact; some even nave Histogram previews
that you can use 35 3 built-in exposure guide.




CHOOSING IMAGES FOR WORK

R [ B e i R A AT

yourself more time to enjoy your creativity.

l am a great believer in making life as easy as possible, and
this applies to choosing photos for printing. My philosophy
is that time spent correcting a poor image leaves less time
for creative thought and applications. So, whenever possi-
ble, | choose well-exposed images to make prints.

The most troublesome types of images with which to
work are those that have very high contrast, those that
are overexposed, and those with any problems caused by
flare or fogging, Guess what? Negatives, prints, and slides
with these problems are just as troublesome to work with
in the conventional darkroom. Although in many cases
vou can fix problems more easily in the digital darkroom,
software is not a cure-all.

By making prints from well- exposéd- |mages you Il leave

[ have heard many photographers voice a new casual-
ness about exposure and technical matters by saying, “I'm
not worried—TI'll fix it in Photoshop.” Yes, in the digital
darkroom you can fix problems that would be very diffl-
cult to handle in the conventional darkroom. Too often
these folks have learned the hard way and have spent so
much time trying to fix those images that they soon
change their ways. These programs are pretty amazing,
but working from poorly exposed images means you have
a lot of work to do just to get them close 1o being accept-
able. The point is, just because vou're now in the digital
world doesn’t mean you are exempt from making good
exposures and choosing good images 1o print.

el T A T THEEITE

] DIGITAL IMAGING SOFTWARE
:

Visit a computer-supply store or surf the web and you'll
| natice dozens of versions of digital imaging software. Which
"| is the best to use? My choice has been Phatoshop (the full
| version) and, for quick fixes, the more affordably priced
' Photoshop Elements. But you might have gotten different
| software with your digital camera or have been attracted to
other programs. In truth, most programs can do lots of
magical tricks for you. | strongly suggest that you choose a
| program that offers Curves and Levels controls, a
| sophisticated color converter, Layers, Adjustment Layers,
Blending Modes, and the ability to work with Layer Masks, or
the equivalent (see Chapter Four for more on these features).
Another type of software you might want to explore is
called a Plugin. This software works in conjunction with most
popular image-manipulation programs and offers one-touch
special effects and solutions for reducing grain, increasing
sharpness, and placing graduated density filters in your
image. While most Plugins are created for color work, an
increasing number are dedicated solely to black and white.
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If vou zre still shooting film, make
exposure and development tests to
see which images scan anc print
ell. Experiment with different ex-
posure technigues and developing
iimes. The negative on the s
unaerexgoses and somewhal
undercevelopec—note Lhe lack of
detail in the piles and the high

contrast between the shadow
anc nighlights, This should be a
tipoff tnat the regative will be
difficult ta print, gnc it s, Jusl & 1.h

stop increase and a 10-percent

nerease in developing lime yieldsa
much betler negative [opposite
paage), The shadow detail in the piles
iz the telling difference: Note now

much rmore cetail is present in the

nositive, Printrmzking will always

make you a beller photographer,
and be'ng a petter photograoher
ays makes Tor easier print-

0, and better results,

(70 N T
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CHAPTER FOUR

Easy-to-use software tools
give you a great amount of
control over every aspect of
an image —especially tonality,
contrast, and sharpness.
Master these tools, and they
will help ensure that you
produce great prints.

FH




DIAGNOSTIC TOOLS

Two diagnostic toois are espeually useful When workmg W|th exposme and
contrast. The grayscale step wedge helps you calibrate your monitor to
make sure that you are seeing all the potential values in an image on your
screen. The histogram is a graphic representation of tonal values in your
image and indicates where to make adjustments.

THE STEP WEDGE

Starting out with a well-calibrated monitor is essential. In
fact, perhaps the most frustrating part of digital printing is
failing to match the monitor image with what shows up
on the print. Bringing input (the monitor image| and out-
put (the print| as closely together as possible will reap
great rewards and save you lots of time and frustration.

You can make some of the necessary monitor adjust-
ments using Adobe Gamma [usually in the Controls panel
on a PC| or ColorSync {for Mac users). You can also use
special software and hardware to make calibrations, a
more sophisticated solution that provides finer tuning and
is worth considering as you become more involved in
printmaking. Once you've calibrated the monitor, a step
wedge allows you to check monitor contrast easily.

A step wedge s simply a visual representation of tonal
values and shows how they might be rendered on the
print. Tonal values in your prints will range between two
extremes in the grayscale—paper white and ink black.
Paper white is just that—the tone of the paper you use.
Ink black is what you would get if you took a brush,
dipped it into the ink cartridge, and painted the ink onto

the print. The other gray values make up the remainder of

the intermediate scale. You can make a step wedge show-
ing up to 256 levels of gray, or simplify it into larger
groups. One that breaks tonal values into 21 groups ade-
guately shows what's going on with your printer and
monitor.

Another important function of the step wedge is to
check whether your gray values have a color cast or a
color shift in different levels of gray. If they do, there’s a
chance that you will get split color on different gray val-
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ues in the print, a very bothersome problem. [f your scan
or image is in RGB mode, go to Image>Mode>Grayscale.
A prompt will ask yvou to decide whether or not you want
to throw out the color information in the image. By click-
ing OK you should help correct the color shift.

YOUR DIGITAL TOOLBOX

The taols | discuss here have to do with exposure
(tonality), contrast, and sharpness. Many other tools
are available to you as well, but this is not a book
about everything you can do in the digital darkroom.
My approach is fairly simplified, and | tend to use
tools over and over again. The tools | cover will allow
you to accomplish just about every task you need to
praduce high-quality digital black-and-white prints.

My reference in this book is Adobe Photoshop,
version 6 and above, though you may have some of
these tools or all of them in other imaging
programs you might use. In some cases the tools
you have at your disposal may be similar to those |
mention here but have different names—you
should be able to recognize them through their
function. Don't be too concerned if you do not
have every tool | mention, as there are many ways
to arrive at an image solution. Indeed, even the
methods discussed here have many variants, and
the way | arrive at a technique might be different
from the one you end up using.
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Levels... Ctel+L
Auto Levels Shit+Ctl+L
Auto Contrast Alt+Shft+Ctd+L
Ctrl+M
Color Balarice... [Cirl+H
Brightness/Contrast...

Hue/Satinatio

Besaturate
Replace Color...
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Channel e,

Gradient Map...
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To create & step wedge, create a new document at 100 dpi, 8x10, RGE.
This yields a olank canvas, If you will. Use a rectangular marouee
[selection tooll set at 0 feathering to draw 2 rectangular selection on the
screen. Mext choose the gradient tool and set it to defzult, or black 0

T tne box, making

white. Draw a straignt line between the long ends o
sure to start right at ane ecge and end at the opposite ecge. [To keep the
[ine straight use the Shift key as you draw,) Release the mouse woen you
reach tne end of the line, You should now a oack-to-white gradient
ir the bax you've created (1), Then go to ImagesAdjust=Posterize {2] and
Type "21"in the dialog box. This breaks the grayseale spectrum into 21
steps, fram deep black to "open” white (3] To sec the effect contrast

cnanges have on the tonal flow, go to Image=Adjust=Llevels and drag
the niack-and-white points in towerd tne center. The result shown here
[4] cames from this step, This compression of tores is the same that will

OCcur Gn your images wnen you adjust contrast witn these settings,

Invert Ctrl+l
Equalize...
Threshold...

s

Variations...
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THE HISTOGRAM unique, with its own spread of values—there is no good
The histogram is a graphic representation of the range of  or bad histogram per se. A histogram in which values do
brightness values in your image. It is a visual map of tonal ~ not flow from end to end does not necessarily indicate a
spread and allows you to judge how well you have ex- “pad” image—it’s just that the tonal values in that image
posed the image. A histogram is a true shortcut, at times, ~ may be very light, dark, or absent in some areas.

to image correction, especially for contrast control. When A quick way to adjust the tonal spread in an image is
you open an image in Photoshop, take a look at the his- to open up the Levels slider control and move the black-
togram. (Go to Image>Histogram on a PC or Image>Ad- and-white points in the Levels dialog box to where they
justment>Levels on a Mac.] Notice how the values are just “touch” the edges of the histogram readout. This
spread across the grayscale spectrum. Each image is spreads the values out to encompass the tonal spread.

[his painting on tne Berl'n Wall
[“gnt) shows a gooe spreac of
values. A slight shifting of the
black poinl toward the center
would make the image even
richer, Tne nightights on this
ouilding (opposite, top left] are
slightly clipped, but the tonal and
textural values are cerlainly
redeemable. The church interior
(opposite, top right) is
underexposec, as seen n tne
clioaing and "crowding” of the
shadow values. [Nate the
highlight "olip" crealed by the
light ir the window.] See page 80
for a quick fix an this
underexposure,

— Channel: rLuminasity :|

I

Mean: 133.34 Level:
Std Dev: 4354 Count:
Median: 128 Percentile:

Pixels: 1920000 Cache Level: |
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— Channel: | Lurninosity

Mean: 159.39 Leval:
Std Dev: 60.96 Count:
Median: 145 Fercentile:

Pixels: 1920000 Cache Level:

—

~ Channel: | Luminosity Flas

o
Mean: 35.89 Level:
Std Dey: 40.37 Count:
| Median: 28 Percentile:
Pixels: 1920000 Cache Level: 1 |
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— Channel: | Lumninasity j

...

|
Iviean: 9145 Level:
Std Dey: 63.09 Count:
| Median: 85 Percentile:

Pixels: 1920000 Cache Level: 1
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By gaing ta Layer=New Adjustment Layer=Levels, yau can fill tne gamut of the

histogram, an casy v fix flat images [tnose with [ittle or no contrast] or those
that have been poorly exposed or scanned. Filling the gamut simply means maoving
the Black and White slders close ta where the histogram ‘nformation begins. You can
lweak tre image further by working with the Middle Gray slider. In & Levels ad]ustec
image [abave), the inlerior revesls many mare detzils and the resullant histogram
shows mere of g spread thraughout the tonal gamut. A somewhat flzt image
{oaposite page) s brightened oy making a Levels adjustment. A fisld of sunflowers
[nage 82) shows a fairly good tonal range, but the histogram revezls some space on
the hignlight side, By moving the White Point slider to the left, the greater tonz!
potential of the image 's revealed.




b

— Channel: ] RGB -| =

Input Levels: iD 100 143

i,
Output Levels:
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Load...

Save..

dddd

Auto

= = = = = |
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' SETUP OPTIONS

When you first load Photoshop you should make some @ Go to View=>Proof Setup>Custom and select the

quick adjustments that will help ensure that the prints paper and printer with which you will be working.
you make match the images you see on the screen. If The choices should include any standard materials,
you fail to follow these simple steps, your experience assuming you have loaded the print drivers that came
will be much more frustrating than it should be. along with your printer. If they don't, you will have to

locate or create a profile and place it under the

Custom profiles area (see page 154). When you make
your selections, you will be given a choice of working

in Perceptual or Relative Colormetric. Perceptual is in
general mare saturated, and is usually associated |
with color printing, while Relative Colormetric works |
better with black and white. This does not mean you
should always choose one over the other for each

image you print; experiment with both to see which
suits the image at hand. And finally, click on Black

Point, as this will give you richer shadow values.

e Open the Color Settings dialog box and go to
Edit>Color Settings. Choose US Prepress—not US Web
or another setting. For Working Space, choose Adobe
RGB. Also check the boxes about preserving the

i working space of the image you load. Work in the

color space in which you scanned or photographed.

® Do a Save As and make a copy of your original. This
keeps the file safe and allows you to feel freer about
exploring all the possibilities in your work. This is
| unnecessary when working with Raw file formats, as
you will save the Raw conversion as a TIFF when
you bring it into your editing software.
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ADJUSTMENT LAYERS
AND BLENDING MODES

e

T —

W|th these |nd|5penseble tools, you can atter contrast change exposure
work on selective tonal control, and do much, much more.

Adjustment Layers are, in effect, a collection of filters,
each of which can affect nearly every pixel in an image.
[n addition, each of these filters has what you could call
an “effect rheostat”™ that allows you to dim, or turn down,
any effect to the nth degree. You can apply these filters
globally (across the entire image) or to select parts of the
image. Think about Layers in terms of a tall box with nu-
merous slots. You slide your image into a slot at the base

When you work with Layers yau can also apply

of the box. Then you slide various filters in and out of the
other slots, while watching from the top of the box to see
the effects these filters are having on the image.

You can use as many Adjustment Layers as you wish,
but to keep some sense of order try to limit yourself to a
reasonable number (maximum five| as you begin. When
you become more familiar with Layers, you can, of
course, use as many as you deem necessary. But using too

Blencing Modes, availanle either in the Levels
dialog box of 5 Mew Adjustment Layer or via

the Layers palette. | use Blending Mades as
exnosure controls. In this scene an auto-

exoosure selling was fooico oy the bright,

reflective white and renderec it Loward 2
middle gray, as 't is calibrated to do. |

corrected tnis easily oy applying a Screen cm—— —

Blending Made in the Layer=New Adjustment w— - -
Layer=Levels step.

e S mrETTTI

| |

LAYERS PALETTE j ————

The Layers palette shows the S p—

background, or ariginal image,

i and the Layers, Adjustment

| Layers, Blending Modes, and

masks you may have applied.

Once you have created a Layer

you can use the palette to |

modify it with the Opacity '

slider. Grab the arrow under

the slider and move it left,

away from 100 percent, and

|
you'll see the effect diminish. F
|
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A Wultiply Bleraing Mode can oe used to increase image density by about a stop. You access

Blending Modes elther thraugh the Layers pelette or through a New Adjustment Layer. This image
required 4 bit more density, which a Multiply Blending Mode supplied immeaiately,

many, in my view, points out that you've made things 100
complicated. Layers do provide endless possibilities for

ground image, when working with Adjustment Layers, so

you're able to play many “what if” games without disturb-

ing the original information. Plus, you can turn the effect
of each layer on and off to see if you like the result as you
work. {In Photoshop vou do so by clicking the eye icon
next to each Layer on and off.]

BLENDING MODES

When you are working in Layers, you can choose what
are known as Blending Modes to work with contrast and
exposure adjustments. (In the Layers menu, choose Lev-
els, and you will see a box labeled Modes; click on the
arrow, and options to work in many different modes will
appear.) Each Mode creates a specific interpretation of the
image and provides a different correction technique.
Here's what the three Modes | most commonly use do.

 Multiply increases exposure by about a stop. As in dark-
room printing, you get a darker print and more density

modifying your images: You don’t touch the base, or back-

as you increase exposure. This increase in density, how-
ever, does not change contrast. [ have used Multiply
very successfully to add density to underexposed images
and to restore faded prints; in fact, this tool is invaluable
in rescuing faded images from the old family album.

e Screen decreases printing exposure by about a stop. As in
darkroom exposure, you get a lighter version of the image
as you decrease exposure, without a change in contrast.

¢ Overlay is a quick contrast control and changes contrast
by about one stop. [This would be like changing con-
trast grade in the chemical darkroom by +1, such as
going from a grade 2 {o a grade 3 paper or filter when
using variable contrast paper.| The exposure does not
change, even though the increase in contrast makes the
print appear darker.

The best way to see the effects of these Modes is to put
an image up on the screen and try each Mode. You'll see
how quickly these Mode applications alfect your image
and how they can make a big difference in how you work
going forward.
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~ LAYER MASKS

e

' Thisis one ofthemroost valuable tools at your d|sposal It allows'you to
combine various elements of the different Layers you have created.

In the photographic darkroom, masking is a technique that  this way you can incorporate dilferent elements of the var-
works with some form of light resist—film or dye—to con-  ious Layers you have created. Let’s say you have created a
trol contrast or exposure on select portions of the image. Multiply Mode of an image and it becomes darker. How-
Masks are {or were) used extensively by commercial print-  ever, you don’t want the entire image to go dark, just se-

ers, although fine art printers knew the trick as well. lect portions of it. The first step is to make sure that you've
The digital darkroom equivalent of this technique is a highlighted the Layer you want to work on, the active
Layer Mask, one of the most important tools at your dis- image, in the Layers palette. Make sure a Layer Mask is

posal. You use Layer Masks to reveal the Layer (or Layers|  available (check that the icon is in the active Layer]. Next
beneath the Layer you have created to apply an effect; in choose a brush and literally paint away the areas in the ac-

Trese cnemical tanks on the outskirts of Kalispell,
Mortana, couc use @ bit of cantrast ana exposure
helo, The first sten was Lo open uo the contrast and
exposure on the white tanks using a Screen Blending
Muode [below). The next and fina' stage was painting
hack the sky using the Layer Mask technique [page
87). The Layers palelle shows these simaole steps,
Mote the Layer Mask icon (the circle within the
rectangle) in the active (blue hignlighted) Layer
(belaw). This mask is gutcmatice ly inserted when
you make @0 Adjustment Layer. For ather Layer
types, such as g duplicate Layer, you have to creale a
mask. You co this by making tne Layer active by
clicking or it, then clicking en the mask ‘con at the
bottom of the Layers palette.

IScreen :I Opacity: m
Lock: T B8 M2 T @

GO olelalT],
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tive Layer you want to eliminate. You need to check the

foreground/background color boxes at the base of the tool

palette and make sure that black is in the foreground box.
When working with Layer Masks:

e You can choose any size brush and brush edge you like.
[An easy way to change the size of a brush is to use the
bracket keys. Press the right bracket key to enlarge the
brush and the left key to make it smaller.|

e You can use Layer Masks to change the opacity, or de-
gree of effect of each stroke. At 100-percent opacity you
go right down to the lower layer with one stroke; at
lower percentages you can paint back with any degree
of effect that you desire.

e As you brush back you should consider using the zoom
tool to get closer to finer areas within the image, espe-
cially when tonal areas are close and there is a lot of de-
tail within the image. If you overstroke, or affect an area
vou did not want to change, it's easy to paint the area
back. All you need to do is flip the foreground color box
so white appears as the foreground color; you do so by
clicking on the small toggle arrows in the box. You then
paint back to the original value or, setting the opacity
higher or lower, modify your Mask.

e You can fill the Layer Mask with black, simply by hold-
ing down the Alt (Option| key when you create a Layer
Mask. This reverts to the original image and allows you
o paint in the effect.
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Layers and Layer Masks are ey o very fine
image enhancement and carrcction. You can
comhine effecls and use numerous Layers to
get the effects you desire. First | gave this
image of g cluster of ferns (1] mare density
oy applying a Multiply Blending Mode o the
“rst Levels Layer (2], | set the Layers palette
Opacity slicer &t 47 percent, which vields
about half the full +1 density effect other-
wise obtained. | then created a Duplicate
Layer (Layer=Duplicate Layer) and appliec 2
blur filter {3]. | created & Layer Wask in [hat
Layer by clicking on the Layer Mas< button
(second from the lett at the base of the
Layers palette| then erased some of the blur
Jsing & Paintbrush tool [4). | made a Final
twesk [5] by applying another Levels Layer to

lighten the overall exposure. The Layers
palette shows the Layers | used and how the
Masks were defned (6],

INormaI *I Opacity:

Leck: B F 4 T+ T @

@ [ M % Levels 1 :—I
—
li Background copy

a

4
28 s | P
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Triis scene, shat in Tent Rocks, Mew WMexico, shows how you can adjust both exposure znd colar
tone using Layers. The original image is reproduced on the far lefr. Subsequent steps are shown
left to right. The first step is to apply a Mulliply Blending Mode then paint back certain areas 1o
get the desired tonal values, Aller achieving a tonal balance, | painted certain areas back using 3
Layer Mas<. Then | added another Layer [Laver=New Adjustment Layer=Hue/Saturation=Colorize]
to create a warm brown coloriza

an.
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Layers and Masks allow you to refine images ir
mary ways. | made this coseup of @ horse (top
left] with a digitsl camera and applied a Sereen
Blenaing Mode to open up the image [above
lef2). Then | apoied & Layer Mask and painted
bhack sarre aregs for a d fferent interpretation
(top right). The History paletie snows the steps
and strokes znd the Layers palette shows the
effect of using just one Layer and the
accompanying Mass, To me, this is the simplesl
anc most direct way Lo nave 1onal, contrast,
and exposure control over an image.
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~ BURN AND DODGE TOOLS

Burn énd Dodge tools prowde an eaJy way to do
touch-ups and make quick fixes of highlight and

shadow areas within an image.

When you open the Burn and Dodge tools, look at the
menu screen and find the Range and Exposure boxes.
Range controls allow you to choose highlights, shadows,
or midtones. In essence, these ranges define the tonal val-
ues the tool will affect to the exclusion of the other val-
ues. For example, choosing highlight allows you to dodge
a highlight area without affecting the other tones. Like-
wise, by choosing shadow, you can burn in a shadow area
without changing the highlights.

Exposure determines how effective each stroke will be.
[n general | keep the exposure quite low—usually abourt

15 percent. This way, [ can build up density when burning
or decrease density when dodging in gradual steps. [ have
much more control as a resull. I do not stress using Burn
and Dodge tools, as 1 feel that most of the effects [ seek
can be attained using Layers and Blending mades. [ do use
them sometimes o touch up an image and do some final
refinements. For example, [ might use the Dodge tool to
brighten eyes or add gloss to lips in portraits and the Burmn
tool to finish up an edgL burn. If I do use these tools, I al-
ways do so on a Duplicate Layer, so any miscues do not af-
fect the background image information.

THE DIGITAL ADVANTAGE

Burn and Dodge tools allow you to add or reduce density
. (exposure) in select areas of the image. In the traditional
‘ darkroom, you add or hold back light by using your hands,
cardboard, and various wire-attached tools. The process
| requires lots of patience and testing and you don't know if
! you've achieved the desired effect until you've run the image
. | through the developing bath. The process is much easier in
‘ the digital darkroom, because:

® You see what you get when you apply the effect, stroke
by stroke.

| e There's no need to process the print to see results.

® You can modify and control the techniques to very finite
| . degrees.

‘ | ®You can burn and dodge different levels of tonality without
affecting others (for example, you can burn a highlight and
have no effect on a shadow area right next to it).
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This industrial scene (tap left] got a special effects treatment wnen | applied a Find Edges filter
(Filter=Stylize=F nd Edges] an a Duplicate Layer, | then applied a Layer Mask and painted back
portions using a Paintbrusn tool (bottam).
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Burn and Dodge tools ca vs Use these tools an a
Duplicate Layer. This se ges displays tne nrocess of "painting in density" using the Burn oal
seton Midtones, 18 percent. When working witn these tools, keeo the exposure low, as this gives you

maore control. Strokes are cumulative, so you can go as dark or light as you want in a graduzl fashion.
| Y g ¥ :
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'LEVELS AND CURVES

Levels and Curves ailow you to maximize tonal spread or to
compress it for various image effects. You can also use
these tools to open or compress very specific tonal areas.

LEVELS

Levels controls work with a histogram readout of the
range of tonal values within the image (see page 78 for
more on histograms|. Levels displays the conlrast range
and lets you modify it, then redistributes the tonal values
throughout the image. When you have an image on the
screen and open the Levels dialog box, you'll see a
graphic representation, a histogram, of the range of tones
in the image. Going from left to right are the shadow-to-
highlight values, with 0 being black and 255 being white.
Using sliders, you can adjust what are known as the black
point and the white point—that is, the darkest and light-
est parts of the image—and the midtone grays.

Open Levels and apply the controls to a variety of im-
ages. Note how the tones are distributed, then move the
sliders to see how the contrast changes. Move the White
Point slider to the left and you will see the contrast increase
in the highlights; move the Black Point slider in and you'll
see the darker values become deeper. What you are doing
is actually compressing the tonal values of the image,
changing the spread of tones by working with contrast.

The Middle Gray slider is probably of special interest to
anyone who has worked in a chemical darkroom. When
you set an overall contrast range with the Black and
White sliders you are defining the parameters of high-
lights and shadows; you change those values with the
Middle Gray slider. If you move the slider to the right the
image becomes darker; to the left it becomes lighter.

Another control you'll find in the Levels dialog box is
Qutput. This contains only Black Point and White Point
sliders. If you go to print and find that highlights are out
of control, you can move the White Point slider in to put
a slight veil over the image and tone down the highlights
so they gather some ink on printing. Similarly, you can do
the same with shadow areas. This is a fallback position if
you just can't get the values right and want to do a quick
tweak before printing,

CURVES
Curves allow you to control both the overall contrast and
distinct tonal values within your image. [ could write a
book just about Curves, but for now let’s look at them as
a contrast and tonal-value control tool.

The Curves dialog box looks very much like the classic
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tone curve used to plot photographic exposure and the re-
sulting density. The diagonal line shows a progression from
dark to light values from the lower left to the upper right.
Play around with the Curve and you'll see how much you
can change an image with just a few movements.

If you want to change the value of a specific set of tones,
open the Curves dialog box, move the cursor into the
image, and click on it while you hold down the Control key
(the Command key on a Mac|. This locks the point on the
curve that indicates those specific tones. Then you can
move the point up or down from the diagonal line to lighten
or darken that value, respectively. For example, say you
have a portrait where the face is shadowed by a hat and you
want to open up that area. All you need to do is click on the
image while holding down the Control (Command| key,
then move the point up until you get the value you want.
Do this with restraint, as too much of a correction whacks
out the curve and can cause some very odd effects.

It might take some pl‘aCLiCC before you're comfortable
using Curves. But you'll probably soon find that they are
fairly addictive and offer controls that can help you en-
hance every image.

Input:

Cutput:

The Curves dizlog box is one of the most powerful image adjustmenl
toals. You can ac mage=Adjust=Curves, or the preferred
method, Layers=MNew Adjustment LayersCurves,




oY [ 3]

QK |
Cancel ]

Load... |
Save... |
Srnioath |

Auta |

¥ Previaw

Input;

Cutput:

Curves can provide a guick fix for many images. A slight twisl on the Curve [above left)
opened up the midale values in this close-up of a leaf; all | needed 1o do was hold
dawr the Control [Command] key while clicking in specific miadle tonal values,
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Tnis pnota shows a lot of contrast and reeds acjustment in both hightight arc
shadaw areas [zap left]. The best method Tor correcting imaces is first to take care

b

= =I5l

o | 7 ! . A ; Channal: Gray
of the foundation values (those that mignt dominale considerations wnen
nrinting), then to deal with the rest of the image. Here, | dealt with the shadow / Cancel
areas (the lower porlion left of the curve; top rignt) 2nd then used & Duplicate
Layer to ourn down the highlights [ooposite page). A Load.. |

P Save...
Srnoofh
7 A

Preview

ddi

\\
N
[

N

Input:

| Output:
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1
m]
b

di

Cancel

iy Load...

Save...

Smooi

ddi

- Auto

Preview

|
N

<

Input:
Output:

In this landscape photo, 2 slight movernent of the
Curve gave just tne contrast kick | wanted.
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A photo like this is often best left oehing, but | snow it
nere to exhibil the amazing power of Curves cantrols,
This is a fairly odd curves change, but it did the job.

|
0
[x

Cancel

|
I

Load...

g
®

Srnooth

=g
=%
5]

B

<

Previaw

Input:
Output; m
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¢
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| phatographed this fiddler in the shade of & tent [above],
creating a backlil situation. Se, | selected the shadow area [a
process that identifies an area to be changec while
arotecting other areas from change; see page 116 then
openec up the shadows using Curves controls,
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Input:

Output:
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This photograph of trees has a good range of values but | (ol
wanted to play with its possibilities. | opened up the nighlight B
and shadaow areas with a bowed curve. When | chose the Curves fhois
la i1 oo o e = r ll E -
mnrrg 35 an Adjustment Layer, th.: program ¢ earted a Layer ’;; Ea|
Wask in the Curves Layer. | ther painted back the image to get
variety of values and tones. Here's the Layer palette that shaws Load. |
the steps. save.. |
Smooth I
| Auto |
'
[Normal | Opacity: [100% B Privew
¢
Lck: T T2 T4+ T a
Input:
Output: |

[ &. IjJ_D_I_QJI_EIJ_!_ﬁJa
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~ TONAL GRABBERS AND FILL TOOLS

o

Flltehmue rovfdes; a:w'y to Manufacture tonal value and
can be invaluable when working with burnt-out highlights
that essentially have no detail.

[f you were working in the chemical darkroom, you would  in the toolbar. Move the cursor, which becomes the eye-
use a technique known as flashing, or fogging, to bring dropper, over the tonal value you want to pick up. When
some tone other than paper white to the overly dense areas  you click on the mouse you'll notice that the foreground
of the negative. In the digital darkroom, fill technique isan  color box loads the tonal value of that area. Select the

alternative to lifting a tone from one part of an image, or area in which you want to add that value and go to
another image, and adding it to another area that has no Edit=Fill. From the dialog box choose “foreground color”
detail. and an opacity of about 15 percent (this way, when you

Images that have been exposed incorrectly, overdevel-  fill the value over the image, you won't obscure the detail
oped, or badly scanned often Jack detail. To correct them  beneath it). Click “OK" and the area will fill up with the
with fill technigue, you'll use the Eyedropper tool, found tonal value you've selected.

This image of a waterfall recorded with no nighlight texture.
Rather than let the arez go to paper white when [ mace the
print, | decided to give it some density with gray fill. First, |
selected the waterfall using & control knewn as Calar Range
(found in the selection submenu] then added gray fil with a
low opacity using a Color Fill Layer. Then | inverted the
selection and added some Lonal variety o the rock wall. The
Layers palette shows the steps.

|Fl.l'.|ultipfv 'I Opacity:
Lock: Tl T 4 T I'@

8

=
A A Y
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In this photegranh of aspen bark [too left], the
highlights recorded toa brightly. | chose a Fll
Adjustment Layer (Layer=Colar Fill Adjustment
Layer] anc selected gray &t & low percentage
(too great a percentage would abscure the
image) to adjust the highlights. | then painted
pack some of Lhe highlight areas for a beter
sffect, using a Paintbrush tool with a low
opacity to have more control.
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WORKFLOW

Simply put, workflow is the "order of march” you use
to work on your digital image files. When you first
put an image up on the screen, you should reflect for
a moment an just how you can apply the tools at
your disposal. Consider what might best suit the
image and how each tool and technique can be used
to correct flaws and enhance the image. Each person
defines his or her own best way of working, de-
pending on internal logic, but the aim is to simplify
the work so that it goes smoothly and that each step
follows the next.

In some cases the steps you take will follow their
own course and reinforce your instincts on how you'd
like the image to be completed. In others you should
allow yourself some room for experimentation and

ol

N
1. The original image was made with a digital SLR. Window light
comes from the side and to the left of the subject. This was a fairly

quick candid, and after bringing it up on the screen | noticed that
there were distracting elements coming from right behind the
head of the subject. My first job, | knew, was eliminating these
and controlling the light.

3. Here's the look on the screen after
application of the Gaussian Blur effect. |
didn't remave the distracting elements
completely, but my efforts got me close
enough. | knew | would work more on
these problems later.

surprises; this will give you more creative space and
bring you along routes that will lead to entirely new
types of visual expression. The beauty of digital
printmaking is that you are encouraged to make such
creative forays, as you can always double back using
the History palette and Undo commands as you go. In
addition, working on Layers lets you modify each step
as you go.

In order to help you establish your own personal
workflow, here's an example of how | worked on one
image, a candid portrait photographed with window
light. You might find other ways to work on this
image. As you work you'll discover your own best
workflow and apply it to the types of looks and tonal |
plays that best suit your own images.

e

R

2. | made a duplicate Layer (Layer=Duplicate) and then opened the |
Gaussian Blur filter. | moved the slider fairly far over to the right
until | saw the amount of blur that would get rid of those i
distracting elements.

e s e S| Rl

b

s SRS

HOGSKOLEN | Sulovin
BIBLIOTEKET
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[Normal v | Opacty: | 100% »

teck: [ &+ @ Fil: | 100% »

5 0 - ¢ 33

4. Being a Duplicate Layer, a Layer Mask wasn't automatically
inserted into the Layer. | added one by clicking on the Layer Mask
icon at the base of the Layer palette. In order to "paint in" the
blur, | wanted, in essence, to invert the blur effect. So | held down 5. | then proceeded to paint in the blur effect. When | went too
the Alt key (Command key on the Mac) when | clicked on the Layer  far gver the subject with the paintbrush, | reversed the foreground
Mask icon. This filled the Layer with black. and background color and painted in the clear area.

Shadow/Highlight g| 7. | wanted to play with the
. | tonality, so | experimented with

Ao

S i Lmmy|  Ihe Highlight/Shadow tool

7 . . L=l (ImagesAdjust=Highlight/Shadow)

i a bit. This was a slight adjustment

il =% but helped open up the shadow
= side of the face just enough.

Tanal Wish:

Kadux;

Com: Cometion: <20

Midtone Contrar: 1

Bleck G 001 % Whke O D01 S

[ Sive b Detauts |

[+#] Shaw Mzre Dzsens

6. My next step was to convert to monochrome using the Channel
Mixer. | moved the various Channel Mixer sliders around until | got
close to the look | wanted.

e
Levels P

with the contrast |
ch I RGE b
opened up Levels a": tLG o s
ou EVRISD B 5 P
on an Adjustment lﬂj
| Load...
Layer and tweaked =
the white point a Came
touch toward the i 3 - (Coptens...
center ThIS ﬁrmed Qutput Levek: | 0 255 ¥ f
i | eee——
up the values to * 5| e

exactly where |
wanted them.

9. | then cropped the image to remove any distracting tones at the
edges, and burned down some of the corners with a few strokes of
the Burn tool at Midtones/18 percent.
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SHARPENING AND SOFTENING

" Sometimes you might want to sharpen or pep up, an |mage shglhtiy
Or, you might want to soften certain areas of the image to obscure
distracting backgrounds, enhance portraits, or create depth of field.

SHARPENING

In essence, sharpening affects the edges of pixels and
creates an illusion of a snappier image by increasing the
contrast of these edges. The tool for sharpening is the

Unsharp Mask Filter, an oddly named process for sharpen-

ing that actually means that you are masking out the
unsharpness. In Photoshop you'll find the filter under
Filters=>Sharpen=>Unsharp Mask. When vou choose the
filter you get the Unsharp Mask dialog box, which has
three sliders for Amount, Radius, and Threshold.

¢ The Amount is how the filter is applied and how much
the differences at the edge of the tonal borders are en-
hanced.

¢ The Radius defines breadth, or at what distance from
the tonal edge the application will affect pixels. For
many images you can keep this value at 1 or less, al-
though when working with higher resolution images
(18 MB and above|] you might want to increase the
value to 2, as you are generally working with smaller
pixel sizes.

* The Threshold defines how dilferent the tonal values
have to be for the filter to affect them. In general, you
might want to keep this between 1 and 7, with 1 for
more detailed images, and higher for more subtle val-
ues. It’s a good idea to raise the Threshold setting for

portraits or when you have dominating sky in an image.

Note that there are numerous other settings available. Ex-
perimenting with the variables is key. Play with the sliders
and see how each affects the image. Zoom in and out for
even more critical examination and click the mouse with

the cursor inside the preview box to see before and after ef-
fects. Sharpening is really a perceptual judgment procedure,
and making proofs at different levels of sharpening can be
very instructive.,

There are a few general rules for sharpening.

* Perform sharpening after all your work on the image is
done, as it may generate certain glitches that become
even more apparent with some other changes you
might make on the image.

* If you need to do a lot of sharpening, do it in steps. Too
much sharpening can completely alter the look of an
image, sometimes to the point of ruining it. Also, un-
derstand that sharpening usually increases image con-
trast and that excessive sharpening can give a harsh
impression.

* Sharpening does not fix an image that is blurry (caused
by camera shake) or out of focus. It can tighten up areas
that are slightly out of focus but it's no substitute for
getting the focus right when you make the picture.

Using a Layer allows you to see the results of your sharp-
ening, since you can turn the Layer on and off as you
work rather than having to use the History palette to see
various versions. Create the Layer by going to Layer=Du-
plicate. Once the Layer is in the Layers palette make sure
it is highlighted, and then go to the bottom of the Layers
palette and assign it the Luminosity Blending Mode. This
mode applies the sharpening to the luminance, or bright-
ness value, of the image only. This approach does not in-
Crease saturation in colorized or toned images or zap a
grayscale image.
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When you sharpen you must work with a Duplicate Layer {Layer=Duplicate). Once you nave &
Duplicate Layer click on the Blending Maode butmon an the Layers oaletie and choose the
Luminasity Blending made. This photo of silas is prime far sharpening, gsit's a kit soft and
has & highly graphic look (sbove]. Oree vou apen the Unsharp Mask dialog box
(Filter=Sharper=Unsharp Maskl you can move arou nd tne image witnin the box to geta
close look &t lines and shapes and at the overall effect, All you need do s click and release
the mouse to see the effect in preview. Be sware that mver-sharpening can be guite
destructive and you should avaia it [right],

TS =
2=l
2= E | Ganeel |
‘;,‘%_--sg [# Preview
S
|
E‘] 100%

it = ==:04
Radius: [15 plxets

=

Threshoid ' levels
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SOFTENING

Softening can be quite effective in certain images. With
portraits, for instance, you might want to sharpen eyes
and soften skin values. Or, in a still life, you might want
o add dimensionality by sharpening the object in the
foreground and blurring the background. To create these
effects, use a Duplicate Layer to create a softening effect
on the entire image and then modify it with a Mask. Go
to Layer=Duplicate Layer, then click on the Add Mask
icon at the base of the Layers palette to apply the Gauss-
ian Blur fAlter, found in Filters:Blur=Gaussian Blur [This

As you do when you sharpen an image, you use a Duplicate Layer to so®en. [n this image |
wantec to soften the background (upper left). | created a Duplicate Layer anc then went ta

filter has only one control, the Radius, and moving it to
Lhe right increases the blurring.) Then create a Layer
Mask by clicking on the Add Mask icon at the base of the
[ayers palette while you hold down the Alt (Option] key.
The image reverts to the original [as you have filled the
Duplicate Layer with black) and the foreground color box
goes to white. When you paint you are actually applying
the effect, the softness. If you prefer to have the image
blurred and paint back to the sharper areas, don't hold
down the Alt {Option| key when vou click on the Add
Mask icon.

Filter=Blur=Gaussian Blur and used the controls to soften the entire Image to the point where
the select area was as soft as | wanted il to be (left). | then added a Layer Mask to the
Duplicate Layer and painted back the zreas | wanted sharp, If | wanted to wark from sharp to
soft | could have held down the Alt [(Option) key when | clicked on the Layer Mask outton and
filled the mask with black, then painted back to the softness in the areas | desired (ahave).
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CHAPTER FIVE

e e e N e O T et o

At times you might want to
Isolate sections of an image

and work on them exclusively.
Selection tools and modifiers
allow you to do so. Meanwhile,
toning and colorizing techniques
make it easy to add color to your
images, without exposure to

darkroom chemicals.

C ol b T o 1
Selection Tools

iy [ ik i KA W:‘:f."" e
Selection voairiers

[0 a"Ean and Coloriz Hﬂic\
Monochrome Ime dg8es
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~ SELECTION TOOLS

These tools help \/ou select parts of an |mage and modrfy them whtle protecuncr
the other parts from your changes. The process is really twofold: You select the
area or like pixels on which you want to work then apply changes to that area.

Selection tools are extremely varied: You'll find your favorites and quickly learn

to match the tool with the job at hand.

FREEHAND TOOLS

These tools allow you to select specific parts of an image
by hand, rather than going through multiple steps in soft-
ware. Here's a tip when using these tools: Double click
when you've completed any task with a freehand tool. If
you don't, you'll get a message informing you that your
selection is not complete.

e The Lasso tool is handy for a “quick and dirty” selection. If
you can draw and can translate that talent to the mouse,
you'll probably be able to use the Lasso easily. I use this
tool to work on small areas and usually modify it with the
Quick Mask aid [see page 128). [ also use the Lasso tool
frequently to add or subtract areas from a selection, as a
sort of touch-up to the task. When working with the Lasso
tool for freehand work, [ use a stylus rather than a mouse.

* The Polygon Lasso tool is great for drawing straight
lines around an object. Click to begin a line, release the
clicker, then drag the line to the point where you wish

it to end. Continue doing this until you complete the
shape you want to create, then double click to complete
the selection. If vou hold the shift key down as you
make the selection, the lines you have created will
straighten into right angles.

¢ The Magnetic Lasso tool helps you follow a tonal border
as vou trace around an object. You can work right at the
tonal edge and make three settings. I'requency refers to
the number of pixels at which an anchor point [an area
where the selection is set) will be set. Ldge contrast de-
fines what degree of difference between tonal areas the
tool will recognize. Width defines the number of pixels
berween the tonal areas that will be used to make the
selection. You can feather the selection as well. Users
sometimes have trouble with the Magnetic Lasso as it
can seem to have a mind of its own. If the Lasso goes
off on a wild tangent you can retrace your steps and
click to set an anchor point [to set the selection| then
double click to enclose the selection.

" . = . g
v + [|ER T B | Feather: | 12px | [4 Antralased _j [Erushes | Tool Prassts Y Lever Comps |

When you open a selcction too), a toolbar appears below
and define the selection peramezers. Choose the Magne:
selection: the second is for addine ction; and
designates the blend of the selection with the adjacen:
Caontiguous box. Contiguous on means that the selec
similar pixel addresses will e selected, regardless ol w

i will ne halte

SELECTIONS TO THE RESCUE

You can address two classic problems with selection
tools. One concerns the landscape shot where the sky is
brighter than the ground. When making the
photograph you might have to choose a good exposure
for the sky or for the ground, or make a compromise
exposure that gets you halfway between without giving
you the richness you want in either part of the image.

| The other problem is backlighting, a common woe with
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the ma'n menu al the 10
Tie Lasso toal, and Tour boxes w
ne third is for sublracting from the area. The Feathering box
srea. When you choo

p of the screen, Use this toolbar 1o modity

il appear, Tne first is for normal

= tne Magic Wane loo, youalso geta

en a tonal border is reacned; off means thet a
nere they sit within the image.

portraits that occurs when the subjects falls, as it were,
into its own shadow. Yes, you can use fill flash, and yes,
you can reposition yourself or the subject to avoid this
problem (or just wait for the right light!) but that's not
always possible. While some of these problems can be
solved with the Highlight/Shadow control (available
only in Photoshop CS) or by painting in and out with
Masks, selections are the easy way to go.




The Folygor Lasso too' is perfect for selecling box-
shaped objects, sucn as this factory puilding. A click
begins the selection; after clicking simply drag the
ool to the next carner, then click again and follow
suiT until you have enclosed the shape. This series of
images snows how changes car be made easily using
this selection tool.
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SHAPE SELECTORS

The Shape Selection tools include the Elliptical and Rec-
tangular Marquees and are handy tools for working with
architectural images and images with horizon lines. The
Elliptical Marquee is great for drawing round shapes—
from ovals to circles to egg shapes, and [ often use this tool

for faces. [ also use it for edge-burning, where [ want to
add a slight darkening (without obvious vignetting| to the
corners of my print. The Rectangular Marquee is very use-
ful for horizons and square and rectangular objects. I will
feather as needed and often modify these selections using
the Add, Subtract, and Quick Mask Modes (see page 128).

Shadow/Highlight Shadow/Highlight

Shadaws Shadows
Amaunt: SojES Amaunt: 52
| cencel |
Tonal Width: 30 % [ Load.. Tonal Width: 32
= | Save... =
Radws: Eli] o a Rads: | 27
[#]prevaw
Highlgats Highfights
Amaunt; (1} % Amount: 28
Tanzl Width: 30 % Tonal Width: 42
Radus: 0 px Radius: 26
Adjustments AdISTMENTS
Color Comrectan: +20 Color Comrecton: -2
Midrone Cantrast: o Mdtone Contrast: +1%
Bhck Clp: | 0.01 | % White Clp: | 0.0L % Black Cipi | ©.01 % Whis Ciip: 0.01
Sava As Defaults Save As Dafaults
[#]5hewe More Optians Show Mors Optizns

The latest version of Pholoshop nas a magical
selectionfexposure lool known as tne Shadow/Highlight
K contral {Image=Adjust=SnadowHighlight, which can

(CGaneel ] be used on @ Duplicate Layer. The corrective steps are
largely perceptusl—you move the sliders in the dialog
nox 1o gel the look you want This image ol a deser|

[&] Preview: plant began as a fairly "flat” scan [above left]; | changed

the sliders [left) to open up the tonal values without
having o make 3 selection with the Magic Wand or
another selection tool.
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Layers Y, Channsls Paths »
Mutioly v | Opaciy:[ 100% ¥ ]

Leck: | v+ @ Fil:| 100% * |

(]

e

Background a8

‘fou can use the Elliptical Marguee
to create vignettes, which | use for
edge-burning. One of the best uses
of edge-burning is to create 2
center of light on portraits, whicn
zods @ more oimensional feeling to
the ohoto. | made this aicture with
windaw light. The effect is nice, but
the background has the same light
value as the foregraund (upper
left]. When | made the selection
with the Elliptical Marcuee, |
“eathered &t a value of 22, which
helps b'eno tne se'ection, shown
here in Quick Mask mode (above). |
then used Levels (the dialog box
shiows the mask created oy the
selection; left] to create a nice
darkening wignette around the
subject (below left],
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The Rectangular Marquee ool is great for making quics
selections of square and rectancular shapes, such as Hue/Saturation
this wincow in Curacao that | original y photographed
an color slide film, After selecting the cutsioe wall, | W e -

desaturated the color using the HuefSaturation control ) | ' |

il -

[right] _to yield a near 'm:].n-:}chr'omf' image [abovc.’iqh . Hue: l 250
Then | inverted the selection to open up the remaincer T Cancel
of the image to change [opposite page). ' o ! L -
Saturation: \ 16 J Load...
N :
- ' Save...
Lightness: o
| g o]
: 0 =

o [V] Colorize
i F EZ [ J]rreview ‘
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SELECTION VIEWING
OPTIONS

When you select an area the
selection shows up as a series of
active dashes, sometimes called a
"marquee,” because they look like
the lights on a theater marquee, or
simply as "marching ants.” If these
lines get in the way of your making
fine decisions about the nature of
the work, you can go to View>
Show Extras and unclick that
option. You can then do the work
and see a preview of what you've
done without the interference of
the selection outlines. The area is
still selected, but the graphic out-
lines of the selection have been
taken away. This feature is invalu-
able when you want to edge burn
using the Elliptical Marquee or
when you've selected so many
small areas that you can't make
sense of it all.
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PIXEL ADDRESS SELECTORS

These tools allow you to work on specific groups of pixels
within ah image, so you can change one tonal value {or a
defined range of values) throughout the image, regardless
of where the value resides.

* You can use the Magic Wand as a basis for many tonal
variations in a scene. Select it and place your cursor
over any tonal value in the image and modify your se-
lection for contiguous or non-contiguous (see page 120]
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as well as other parameters (Tolerance is the most im-
portant; see page 126). In this way you can select a
bright sky or other bright highlights you want to
darken, or dark tones you want to lighten. Choose a
low tolerance for images where there are lots of fine
lines and a higher tolerance for general tonal areas.

Color Range, found under the Select menu, allows you to
pick out a general range of values within an image and
select them. The main options are highlight, shadow, and
midtones. For example, say you want to select a bunch of
white highlights in flower petals set against a dark plant;
all you need do is go to Select>Color Range=Highlights
and click, then select every small petal.

The Eyedropper tool is not a selection tool in the proper
sense of the term, but is an invaluable ally of selection
tools. Let’s say you have selected a dull, washed-out sky
with your Magic Wand and want to fill it with a darker
tone. All you need do is pick the selected tonal value
from another part of the image, then, using fill from the
edit menu or using a fill Adjustment Layer, do an
Edit=Fill into the sky. Keep the fill opacity low, at about
20 percent, rather than painting over any details that
might be in the area you have selected.

Jse Color Ranoe, under the Selecl
menu, Lo pick ocut and modify coor,
For plack-and-white orinters, therg
are three interesting options: High
light, Shadow, and Midtones. In this
photo [above left], made in very brighl
light on one of the islands ofl Hang
Korg, the highlights are a ot "hot."
S0, | set Celor Range at Hignlights
and used & Levels adjustment ta bring
them mare under control.



Ta define tona) borders between
the brick face and the wooo on
tnis textural wall, | dragged the
Wagnetic Lasso tool along the
vorders and double clicked when |
had enclased the area on which |
wanted toowork, Tren | used a
Levels adjustment Lo darken tne
brick face.
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SELECTION MODIFIERS

Like many tools select|0n tools have modlﬂers that help in gettmg
just the type of selection you want. These modifiers provide many
ways to define the parameters of the selection before you make it
and to modify your selection once you have made it.

FEATHERING

Feathering defines how a selection will blend with its sur-

roundings. This tool extends the area of your selection
but does so with decreasing opacity. As a result, the se-

lected area flows more naturally into the unselected area.

You can feather before or after you make a selection and

when you choose a Shape Selector or a freehand tool. Go

Once you make the changes on
an image, take some time to
consider the implicaticns your
editing has on the rest of the
phota, You mignt, Tar example,
deeper a sky and then notice
that the logic of the light re-
quires some modification of
the rest of the phota. This is
where Select=Inverse comes
nia play. In this scene |
wanted 1o strengthen the sky
{sbove right]. | made a selec-
tion with the Polygan Lasso
tool along the horizon line
with a Feathering of 22 for a
sofl blend, shown here in the
Quick Mask mode [below
right]. | then used Levels to ad-
just the sky (above, far right]. |
realized that the ground por-
tion was a bit out of syne, so |
inverted the selection and
made a slignt adjustment to
the area (below, far right]. This

B £5-30F 0 25% (Quick Mask)

to Edit>Teather and you will be prompted (o select a
number—the lower the number, the more distinct the
boundaries between selected and unselected areas will
be, [f [ am selecting an object that | want to silhouette, |
use a lower number; il [ am selecting a horizon line, 1 set
a higher number because [ don’t want a hard edge be-
tween the ground and sky.

technigue works especially well
when you need to adjust &n
image in two ar more Lonal
areas and don't want Lo make
an adjustment to the entire
image at once.
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i €5-300 & 33.3% (Background copy RGE)

|| Layers ™ Channels \ Paths
|Mormal | Opacity: [403% I’L
weFPArgr+ra B

Ir some lignting conditions, such as those beneath gn overcast sky, the exposure can
cause the sky 1o go blank, In this scene | wanted to add density to the sky to keep it from
staying paper while [top left], | used the Magic Wand to select the sky [top right] then
used the Eyedropper tool to pick a gray value from the sceng, which plsced thetvalue in
the Foreground Color box, | then created a Duplicate Layer because | wanted 1o be able ta
madify the value later, | then went to Edit=Fill and chose a fill gercentage o 50 percent
and clicked OK, and the sky filled with the value (middle right]. | then modifiea the value
o Laste using the Opacity slider in the Layers palette, moving it back to 40 percens
[bolttom right). This gave me just the density | wanted (botom left),
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TOLERANCE

You'll use the Tolerance modifier when working with
pixel address selector tools. The Tolerance modifier deter-
mines how similar pixel addresses must be in order to be
selected. This tool will only pick up pixels that are very
similar, but you can expand the definition of pixels to be
included in the selection by choosing a higher Tolerance
figure. For example, let’s say you want to change the val-
ues in a sky and want to select so you protect other por-
tions of the image from your changes. The sky might be
uniform or it may have variations. By using the tolerance
modifier, you will be able select all the areas of the sky on
which you want to work.

ADD AND SUBTRACT

Let’s say you are using the Lasso tool and when you make
your drawing you miss a spot. Simply click on the Add Se-
lection box on the menu toolbar and draw in your addi-

tional area. You can also use this modifier to add an area
of selection in another part of the image that is not near
the part you've already selected. Conversely, if you draw
over an area that you do not want to be included in your
selection, you can click the subtract box and draw around
the area to eliminate it. You can use this modifier with
any selection tool.

CONTIGUOUS/NON-CONTIGUOUS

When you make a selection with a Magic Wand you can
choose contiguous or non-contiguous options. The con-
tiguous option determines that the selection will affect all
like pixels until the pixel group meets a different tonal
edge. For instance, you choose to select all gray pixels
until they meet a deep black line. The non-contiguous op-
tion directs the selection tool to choose all like pixels
throughout the image; the selection will not be con-
strained when it meets a tonal border.

When you work with the Magic Wand, use the modifiers in the selection toolbar to work in a Contiguous or
Mon-Conliguaus maae. Seenes such a5 this point out the Loo!'s usefulness, In this selection, Contiguous
blacked the Magic Wand from moving across tonal borders (left). | turned Contiguous mode off to select &l

similar pixels throughaut the frame {rignT).
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GROWING SELECTIONS

This modifier helps refine selections that might be a bit off
by expanding the range of selection to all adjacent pixels
within a tolerance range that you sel. You can set the
number of pixels you want to grow [or shrink) with the
Select=Modify=Expand (or Contract] menu item. You can
also expand the pixel selection to include all similar pixels
in the image by using the Select>Similar command. To
nudge the selection slightly in any direction, use the up,
down, and side-to-side arrow tools on your keyboard.

SELECT INVERSE

By inverting a selection, you remove protection from a
part of an image you've worked on previously and protect
the part you're currently working on. This way, you can

apply changes to other parts of the image to create visual
harmony. This modifier is very useful when yvou want o
create tonal consistency throughout the image.

QUICK MASK

Here’s a great way to check and refine the selections
you've made. After you make a selection, go to the tool-
bar and click on the Quick Mask Mode. The area you se-
lected will turn red {you have the ability to change the
color of the Mask and even its transparency|. You then
modily the selection, using a Paintbrush tool to add to it
and an Eraser tool to subtract from it. Use the Zoom tool
to get a closer look at the selected area as you work.
After you have made the refinements, return to normal
viewing mode.

It was difficult to print this photograph from 2 scanred 35mm negative in tne chemical
darkroom, because Lhe foreground was so bright and the shacow aress were so detailed (left).
Burning and dodging took lots of time and required many test or nts. Tne Shadow/Highlight

0l however, made short work of printing this image well {right].
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Use Quick Mask made to verify a good selection,
You can switch from a normal view of the
marguee [the moving dash lines around your
selection] by clicking on the Quick Mask mode
button at the base of the toaloar. Once in this
mode you can add to the selection by painting
with black as the forearound calor (as shown) and
subtract fram it by inverting the foreground color
to white, In this scene | wanted o maintain the
tonal values on the trailer and darken the
background (above). First | selected a rectangle
around the trailer (to make far less painting) and
switched to Quick Mask mode [far right). | then
added ta the selection by painting in around it,
zooming &s | warked, Here are some steps from
the work in progress [opposite page, upper fght
and left]. | then inverted the selection so that |
could affect the background and protect the trailer
frarm cnanges, and used Levels to carken the area
(opposite page, bottom].
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B ¢5-23.tif @ 16.7% (Quick Mask) =l s g c5-23.tif @ 16.7% (Quick Mask)
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You can use many hicden selection tools, disguised as exposure
or contrast controls, to play with images. You can use tnem in
combination with masks to make many inferesting changes.
The sequence snawn nere works with the Thresnold option
(Image=Adjust=Threshold). This photograph has many graphic
possibilities (abave), The first step is making a Duplicate Layer,
and then opening up the Threshold dizlog box (rignt). The slider
can be moved far varying effects; here's the variztion | enose
[zbove right). Because this is on a dupe layer | could use a Layer
Mask. | clicked the Layer Mask icon at the base of Ihe Layers
palette, which placed the mask inlo the dupe layer. | then chose
a wrush and painteg back the threshold effect using different
opacities to vary the mask depth and effect. Note Lhe Layers
paletle showing how | painted the mask [opposite page, far

right).
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TONING AND COLORIZING
- MONOCHROME IMAGES

....... . ’ —

st e P LS s M TR AIE L A e R i

The lmage color ofevena conventlonal black and wh|te 5|lver print
is rarely black, white, and grayscale shades. It may be warm
(golden), cold (blue), or toned (sepia or magenta). The image color
of a monochrome print is one of the keys to its beauty, and the
digital realm provides many ways to add color effects.

EASY COLOR OPTIONS et e e e S T
A quick way to add color to a neutral black-and-white e f_l_lig
image is to go to Image>Adjust>Variations. Before you do B

o EEE R ShowCiopng

this, however, create a Duplicate Layer of the image so
you have access to all the modifiers a Layer offers. You are
then presented with a choice of numerous color shadings,
which you can control to a good degree in variations with
the shadow, highlight, midtones, and saturation options.
Once you have made your choice, go to the Layers palette
and play with opacity. One of the advantages of this
method is that you can play with the various tonal areas,
fll or reduce the colorization of each one, and see the ef-
fect of your choices immediately. You can also create a
Layer Mask and change the color effects.

Another simple way is to create a New Adjustment
Layer=Hue/Saturation and play with the sliders. When
you do, always check the colorize box. The range of colors
you can put into an image with this box is nearly infinite,
and you can also modify it and use Layer Miasks as well.

Cotbe o
:Mj‘ s ]

T Sehuslion

Fine Tomse St Clocing

e e T e ST

' CHOOSE THE MODE n

There are two choices when working with black- i
and-white images. One is to use the grayscale |
| mode and the other RGB, or color mode. For most |
purposes, you will want the image to be in RGB t|
mode. If you scanned in grayscale mode simply go I
to Image>Mode>RGB to convert it to a form that |l
F, will take the color we are going to give it. Even

though your image looks like monochrome or black |
and white on the screen, you are now working J
with a color-ready file.

One of the easiesl ways to add image color is with the
fzriations tool [Image=Acjust=Yarialions). As you make
selections you get @ see the original and the cnanged
= ] versian, | used this toal 1o give this set of silos a slight
sepia tone.
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You can paint back or madify a colorizing effect
with a Layer Mask. | converted this grayscale
image from a 35mm scan 1o RGB mode anc then,
using Variations in a Duplicate Layer, gave it a
warm-brown, sepis effect [topl. | then created a
Layer Wask for tne Duolicate Layer anc pzinted
neck some of the image (middle] witn a brusn set
atwarious opacities (from 20 Lo 100 nercent), |
madified the final image using burn and dodge
techniques on anotner Dunlicate Layer [bottom).
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Saturabon:

=]
Lightrigss:

Colonza
Fravew

An easy way 1o add a toned lock to a grayscale image [s via Lhe
Hue/Saturation route. Hue/Saturation exists gs an Acjustment Layer,

so it allows for many modi an options. The dialog box s fairly
straightforward, allowing you 1o choose Hue (the overall calor),
Saturatior (the intensity of that colar), and Lightress (which is sa
sensitive that | tend not to use it, but s fine for a little tweaking). |
made these different interpretations with ease using the Hue/Saturation
control (left). Since you're using an Adjustment Layer, you can wark
with Blending Modes, Masks, and the Opacily slider far nearly infinite
calor and dersity variables,
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o emulate

One of the easiest ways
silver-print toning effects is to work
with Image=Adjust=Variations,
wnich you can do ona Duplicate
Layer for even more control. The
first step is ensuring that the image
i5in RGB mode. The Variations
dialog box offers many options.
Here | have created a warm tone

ana a cool tone inlerpretation via
the Variations route.
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DUOTONES
Among the many ways to add color is to create a duo-
tone. Make sure you are working in grayscale mode, then
g0 to duotone, in Mode=Duotone. When you do this, the
duotone dialog box will appear. Here you can access dif-
ferent inks for the mix by clicking on the box at the top
and choosing duotaone (two inks), tritone [three inks], or,
for the truly brave, quadtones (four inks).

Let’s say you choose tritones. In the three boxes that

appear you will select the color inks you are going to use.

A color picker shows up as soon as you click on any of
the boxes, allowing you to set the colors for your mix.
Leave the first box as black, then work your way down
through lighter shades. If you want lo create a sepia-
toned image, you might start with black, then choose a
warm vellow, and finally a warm gray. If you want a
browner tone, you might choose a light magenta gray for

"Bl cobble2.psd @ 25% (Tritone/8)

| Duoctone Options

Type:| Totane: 1

Ink 1: . Back

Ink 2; - D PANTOHNE 517 CWC
l/

Ink 3: PANTONE 420 CVC

Overnint Colors. . B

"R, cobble2.psd ® 25% (Tritone/8)

Duoctone Curve

a0:

| Duotone Options

Ink 1 . [Black
Lozd...
Ink 2: D | PAMTONE 517 CVC e

Type: [ ﬁqne 402338

8
FEE R 2 E 2

= . [#] previewe
Ink 3: # PANTONE 420 CVC N
Overprnt Colors... B

50::
70:

a0: 956
95: |
100: 100

the lower color. As you make these selections you'll see
the color of the image change. If you want to try out
some presets, or “canned” duotone, tritone, and quad-
tone combos, click on the load button in the dialog box.
You'll get a set of folders with presets you can try out on
your image. Il you like one of these preset choices, re-
name the set so you can identify it easily the next time
you visit the folders.

After you have selected colors, you can change the
curve of the color, or how it is laid down in all the tonal
areas of the image. If you click on the Curve box next to
the color, you can manipulate the curve at will, changing
the way ink goes into the various tonal areas. If you do
this on a Duplicate Layer you can modify the image with
all the Layers tools at your disposal. You can even do split
toning here, a technigue in which different tonal areas get
different color sets and intensities.

Ductones present the most possbilities for
color variety, as you can change both the
color (through various Tnk combinatians) and
the intensity of each color by manipulating
tne accomoanying curves during ink lay
cawn. | am not sure just how many combi-
nations tnis might yield, bul my quess is thal
it's somewhere in the millions, Here's the ink
setup box thal opens when you choose
Image=Mode=Grayscale=0uatone (left] If
you click an the accompanying curve nox
vou get this screen, whick allows you 1o play
with the distribution of & particular ink in
the various tonal areas of the print (below].
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Photoshop oflers a number of Presets, or ready-lo-use
duotone ink and curve combinalions. To access them click
on the load button in the Duotone dialog box, This set
resides in the Tritone folder; there are also folders for

duatones and guactones.
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CONVERTING COLOR TO BLACK AND WHITE

| use lots of color images to make black-and-white prints. In fact, color slides are
a great source, as they usually are exposed so that the highlights are well under
control. When you scan a color image for black-and-white printing, keep it in
RGB mode. The best tool for converting color to black and white is called the
channel mixer, which you can choose as a new Adjustment Layer. When you open
the channel mixer you are presented with a box with various sliders. The first step
is to check the monochrome box, which will present a preview of the image in
grayscale. This does not convert it to grayscale mode but just presents it as a
grayscale version of the image.

The sliders allow you to customize the look of the black-and-white rendition
of the image. | find that red and blue affect contrast, while the green affects
luminance, or brightness. As you play with the sliders you'll get a good feel for
how they change the image. | generally drop back on the red and blue and
increase the green.

There are other conversion options, including using Image>Mode>Grayscale to
convert an image to grayscale, or Image>Adjust>Desaturate, which removes the
color but keeps the image in RGB mode. Note that when you convert RGB mode
to grayscale you cut down the image file size by a third without sacrificing
resolution. You might want to do“this if you have a slow computer or your file
size is so huge that even a speedier computer drags along. You can always revert
back to RGB mode for printing later, if need be. | usually keep all my black-and-
white images as RGB images throughout the process all the way to printing.




Ductene Options

Type:| Quadtone v

- — Cancel
Ink 1: Black
_Loag
Ink 2: Z D PAINTONE 407 CVC | s
| Preview
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Qverprint Colors... ==
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Duotones [ang tritones znd guadtones) allow you to
lweak image colar and density ©a an incredible cegree
and allow for refinements that will satisfy the most
demanding printer. This onotograpn can be interpreted
in numercus ways, Here's a quadtone set and curve off
the neutral gray [second ink) (above), as well as the
result. One change in the in<s or curves would offer a
different interprelation,
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COLORIZING TECHNIQUES
You can also add a touch of color to a select portion of an
image or convert color images to black and white that
have just a trace of color. You can even hand paint your
images and give them the look and feel of old postcards,
colored daguerreotypes, or hand-colored portraits. There
are many ways to achieve these effects.

1f you are aiming for a hand-painted look, the first step is
to create a color wash, or foundation, that will serve as the
undercoating of the image. Warm brown, lightly applied,
usually works best. To apply this wash, first create a Dupli-
cate Layer of a black and white in RGB mode and go to
Image=>Adjust=Variations and choose your color base. Drop

back the effect using the Opacity slider in the Layers palette.

Now choose a few colors from the color picker and

Emulating nand-colaring and split-taning
effects in digital is quite easy, and opens Lhe
door Tor many graphic interpretations of black-
ano-white prints, This photo started oul as
neutral gray converled to RGB [right] and then,
after | used Yariations [below) on a dupe layer,
became 3 warm-tone image (opposite, lop). |
ther used 2 Leyer Mask [opposite, top right] 1o
painl back part of the color fram the scene
[opposite, middie); zooming in helps me wark
in small-detzil areas [opposite, bottam right).
The final print lopposite, bottom) is much more
svocative of the mooo of the scene.
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place one in the foreground color box, then toggle to the
packground color box and place one there. This way you
always have two colors on your palette. Start to paint, ad-
justing the opacity of the color between 10 and 20 per-
cent [or each stroke. This creates transparent colors, just
as if you were applying photo oils to a traditional print. If
you need to switch colors, double click one of the color
boxes and move on to the next set of colors.

Another option is to create a Duplicate Layer with
Hue/Saturation, apply a color through that dialog box,
then add a Mask and paint back to the original color. Or,
you can blend colors by setting the opacity below 100
percent. You can then create another Duplicate Layer and
color that. Each Layer is like an acetate onto which you
add or peel away color as you please.
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There are many ways to add hand-colaring effects.
Perhaps the most impaortant concepts are to work
with paints al low opacity and Lo work light'y,
<eeping in mind that you can always vary cxposure
and color ricnness later using Levels and
Hue/Saturstion Adjustment Layers. This forest
seene is prime far nand-caoloring effects (right).
The firsl step is ta choose prime colars with wnich
1o work. | waork with lwo colors at a time by using
the Foreground/Background calor boxes, | click on
the Foreground color box to bring up the Color
Picker [below) and then follow suit oy toggling an
the boxes and choosing a background color. Here |
hiave chosen a light yvellow and soft green as my
lwo prime colors [oelow]. When | start work | just
toggle oetween the t

wo. | work loosely with a soft-
edged brush and vary the orush opacity as | ga,
hut never exceed 20 percent, s this will paint over
details (rignt, bottom). | can glways change the
intensity of the colors later, Here's & stage of the
work after | made a change in Levels Lo increase
coar richness through contrast (opposite, upper
lefz). | then opened the Hug/Saturation control
(opposite page) or an Acjustment Layer and
shifted the colors taward a deep blue opposite,
upner right], knowing that | was going to paint
back much of the scene away from that tint. The
final shows the influence of the blue tinTand how
| masxed it using various opacties on the brush
used for Lne mask. To show how another
adjustment can affect the image, | added another
boost of color through Hue/Saturation (opposile,
potlom).
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CHAPTER SIX

e e i M e s e R e

PAPER AND INI(
Choosing the right paper and

ink, and setting your printer to Printer Setup and
accommodate them, is a crucial eLinEs
5 step of digital printmaking. As
with the conventional darkroom,
8 the choices of materials are broad,

making it easy and exciting to

e

create beautiful prints.
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PAPER FOR YOUR PRINTER

Your chome of prmtmg paper wull have a profound efrect on
how your image prints. Fortunately, you have a wide choice
of papers, from glossy to matte, to silk to canvas, on which
to create your prints.

An inkjet printer creates an image composed of dots thatare  sprayed dots coat it with a minimum of diffusion. In addi-

literally sprayed onto the paper. These dots are very, very tion, the ink and paper should work together so that the
small and are placed with amazing accuracy. The density ink does not smudge or require a very long time to dry
and placement of these dots are what create the illusion ofa  once it’s applied. You will find that printing on different
continuous-tone image. Each paper you use will require a papers might result in different tonal and image color vari-
different amount of ink and will receive the ink in a differ- ations. This can be slight in some combinations, fairly far
ent manner. Some papers are more absorbent than others, off in others. Matching ink and paper can be a daunting
some require a very fine layer of ink, and others require problem, one that is often solved by sticking to a few ink
heavier placement. and paper combinations and learning their foibles and
The paper must be treated in such a way that the how to tweak them for best results.

HOW LONG WILL YOUR PRINTS LAST?

Papers and the inks you use on them will largely determine the long-
term stability of an inkjet print. Recent developments in dedicated
inkjet paper, along with specific ink sets, have created ink/paper
combinations with the longevity of standard photographic paper.

Two-hundred-year pigmented ink and paper sets are now available,
as are seventy-year-plus dye-ink sets and papers. Some papers and
inks, however, don't even come close to these standards, so awareness
is important. Keep tabs on web sites dedicated to inkjet printers or type
n “inkjet printers archival standards” on a search engine. One such site
is www.wilhelm-research.com. Henry Wilhelm and Carol Brower have
been studying image permanence on photographic and inkjet papers
for years, and their web site is an invaluable resource for digital
printers who want to make inkjet prints last.
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Color Settings k

Settings:| U.S. Prepress Defaults v
Advanced Mode
Working Spaces Cancel
RGE: | Adcbe RGE (1938
CMYK: [ U.5. Web Coated [SWOP) +2 Load...

Gray: | Dot Gain 20% Save...

Praview

RAICIE:

Spat: | Dot Gain 20%

Color Management Pobcies

RGE: | Prasarve Embaddad Profiles bt

CMYK: [ Preserve Embadded Profies ¥ |
Gray: ._Pres&r‘.'e Embeddad -Drnfu_i_g_ M |

Profie Mismatches: [v/] Ask When Opening Ask Whan Pasting
Missing Profiles: Ask When Opaning

Conversion Options

Engine: | M

Intent: | Relstive Calarimatric M
Use Black Point Compensation Use Dither {5-bR/channel images)

Advanced Contrels
Dasaturate Monitor Colors By E] %
Blend RGE Colors Using Gamma: [ 109 |

Description
U.S. Preprass Defaults: Praparation of content for common prass conditions
in the U.S,

dalddl

Proof Setup

Setup: i Custon!?& v

Profile:  5P2200 Enhanced Matte_PK e Canceal

[JPreserve Color Humbere
S Load...
Intent: Relative Colorimetric v
i Save...
Use Black Point Compensation

Simulate: []Paper White

kil

Embedded Profile Mismatch

—

The document "VI2K9483.JPG” has an embedded color profile
+ \ that does not match the current RGB working space.

Embedded: sRGB IEC61966-2.1
Working: Adobe RGB (1998) ;

How do you want to proceed?
(®) Use the embedded profile (instead of the working space)
C) Convert document’s colors to the working space
() Discard the embedded profile (don't color manage)

Lok J |

Cancel |

The first step when working in Fholoshop s to
make the colar settings, which you need do
anly once. Go 1o Edit=Caolor Settings anc make
sure thal the working space is Adobe RGE and
the "Settings”is U5, Preoress Defaults. Also,
keeo the "Preserve Embedded Profile” boxes
cnecked, and wark with the emoecded profile
of your image.

To help ensure that the print you make will be
: ® as possible to what you see on tne

n, go 1o Yiew=Proof Setup=Custom and
lhe paper and printer, Choose different
oroofing setups and see now your imgoge
changes accordingly.

This message screen may come ug if you have
chosen Adobe RGE as your working space and
open an image from a digilal camerz, whicn
may have a default working space of sSRGE—
mare color rich but somewhat more confined
than RGE. If you cnange the embedded prole
yau might shift the values ar cclors more than
you desire, so in general maintain the profile as
recoroec.
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PAPER SURFACE EFFECTS
Paper surface and base color have a profound effect on an
image. Just as in conventional pholographic printing, an
image generated with an inkjet will look different if it’s
printed on glossy or matte stock, or if that stock has a bril-
liant white or cream base color. [ often print duotone or
sepia images on warm paper stock to enhance the image.
[ rarely print natural scenes on glossy stock, but [ always
print commercial or work for repro on it. Your personal
choices will be based on taste and tests.

More and more varieties of inkjet papers become avail-
able all the time. Here’s a quick review of some of the
inkjet papers | have used.

e Glossy, photo-qualily inkjet papers are commonly used
for printing color prints, snapshots, and black-and-white
commercial work and for scanning from prints [or re-
production. This paper provides a sharp rendition,
which may be good or not so good for the image. The
effect may be too contrasty for some work and it may
eliminate some tonal subtlety, but it yields the deepest
black and whitest white. This is my paper of choice if |
am doing prints that will be scanned for repro (for
newspapers and magazines|—but that’s become a rare
occurrence, since now I usually just submit electronic
files for reproduction purposes.

Matte heavyweight, photo-quality inkjet papers tend to
tone down contrast yet still deliver an excellent tonal
edge and are often my first choice. The matte surface
holds the ink as well as glossy stock does and is most
suitable for nature, scenics, and even some portraits.
Blacks are deep and whites are bright but not as deep or
brilliant as with glossy stock. So, this paper is probably
not suitable for commercial work in which the print
will be scanned for reproduction, for illustration work,
or for some portraiture. Variants on this surface, some-
times described as “silk” or “pearl,” have many of the
image characteristics of matte but have a shinier finish
and can reproduce luxurious tones.

e (Canvas and textured papers do not, as a rule of thumb,
work well with inkjet printers, but some papers with
textured surfaces are designed to hold the inks well. In
general, [ find that papers with too much texture or
weave tend to obscure the details in the print, but they
can be fun to work with.

e Fine art papers come in a variety of weights and sur-
faces. Many add a luxurious feel to inkjet images and,
because they are usually acid free, aid in the image’s
longevity. They are considerably more expensive than
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stock or standard inkjet papers but may be worth the
price for certain select images or editions.

(Generic art papers, used for standard printing, may be
used for inkjel printing if they are coated properly;
check with the seller or distributor. I have had very
good luck with some of these papers and enjoy the vari-
ety and selection. Most come in a variely of shades and
base colors as well. Unfortunately, these papers do not
offer the long-term stability of some of the other papers.

Special effects surfaces include fabric (silklike material|,

transparent sheets, and other types of media. This op-
tion may be attractive to photographers who use images
for multimedia projects or who just want to experiment.

Budget options are the low-priced papers usually found
al discounters and office superstores. Be aware that
some of these inexpensive papers may not provide the
quality you desire and might not last very long; the life
spans of some are as short as one or two years, after
which colors and tones may fade. Bul you'll save money
using them if you just want to experiment and use the
prints as proofs.
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INK OPTIONS
The fmage cotor of a monochrome print is one of the keys to |ts

beauty, one that a discerning eye will always appreciate. New
inks are enhancing image-color possibilities considerably.

The color possibilities the digital darkroom provides are
very exciting, and the ink options available to you make CHOOSING MODES
digital printing especially expressive. These options ex- _

tend to black-and-while inkjet prints, which can be toned You can print black-and-white images in two
sepia, brown, and even blue for various image effects. modes: grayscale mode and RGB, or color mode.

[ generally use the inks made by the printer manufac- | You can work with either, depending on how your
turer, since ink nozzles are geared toward working with a orinter performs. Some printers yield fine prints,
specific consistency of ink the manufacturer provides. A while others produce satisfactory prints only in
growing number of optional, third-party inks are also | RGB mode. You have to test to determine the
available, and these include grayscale sets that come in o i .
neutral, warm, or cool versions. | have had fun and got- mooe in which your printer yields the most
ten very good results with some of these inks, although satisfactory results. If you have converted your
they do require a special setup when you use them, called grayscale file to duotone or have scanned a toned
“profiling” (see page 154). IU's a good idea to dedicate a image into RGB, then you must work with the

printer in RGB mode. That's how | do most of my
printing.

printer to these inks, or you'll need to clean the nozzle
heads each time you use them with other inks; be sure to
follow the cleaning instructions and use the third-party
ink manufacturer’s cleaning cartridges. Remember, 100,
that most printer manufacturers will void your warranty if
you use a brand of ink they don't recommend.
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When you use arinting papers other than those suoplied by the printer manufacturer, it s & gooo idea
to locate and load the paper profiles, as they will not otherwise appear in your printer eriver sellings.
Some paper comparnies might supply you with settings that are equivalent 1o those used by
manufacturer brancs (opoosite page) or kave orofiles avalable for downlaading an their web sites
(above]. Here are two such offerings from [Ifora, a company wilh a great reputation in Lhe
photographic and Inkjet-printing-paper business
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PRINTER SETUP AND SETTINGS

_T-In a féw easy Stéps you can.-sét up your printer to handle youf
digital images so it produces the highest-quality prints.

When vou're ready to prinl and open the image on your
screen, do a Save As and work on a copy of the original—
this way, you'll always have a backup if the file is written
over. This step is unnecessary if you are working from a
CD or DVD.

Then, if you have not done so before, make sure the
Color Setting on your monitor is set correctly at U.S. Pre-
press (go to Edit>Color Setting in Photoshop and use the
drop-down options to make this choice). In the same dia-
log box choose the working space, which for most images
will be either Adobe RGB or sRGB. [Note, some digital

Image Size

Pixel Dimensions: 17.0M
width: 2000 pixels
Height: 2972 pixels

Document Size:
width: | 5 inches v |
Height: | 7.43 | inches _V_i ]

Resolution: | 400 || pixels/inch v

[ ]Resample Image:

The Image Size dialog nox allows you to put

possible prinl. Tnis box snaws an image that was scanned for 400 dol output [above e

resolution than necessary for a cuality print.

cameras are set at sSRGB as a default while more advanced
digital cameras allow you to choose between the two. |
Choose Adobe RGB for most work.

Then, to ensure that the image on the screen matches
the outpur from the printer, plug in your paper profile.
You do this by going to View=Proof>=Custom and drop-
ping down the choices to lind the paper and printer on
which you will be printing. 1f yvou do not see your paper,
you'll need to load a profile (see page 154); if you don't
see your printer, you'll have to load your printer driver
software.

Image Size

Pixel Dimensions: 16.9M [e}

width: 3008

Lok ]
([ Cancel ]
Height: 1960

Document Size:

width: |41.778 | inches v]

27.222

Height: _ inches ?-|

pb(_els_jiﬁch v |

Resolution: | [

[ ]Resample Image:

in tne gesired oront size arc to set the reso ution [or The pest

ft) and has more

Here, I've opened a 16.9 MB image at screen resolution 72 dpi [above right]. The orint size is very large, but |

woult produce an awrul-laaking print. So,
240 dpi lopposite, upper lefz). Note that

we cnanged the resolution to a good dpi far most deskzop
the print size now becomes Bx12'/2 :
size are interdesendent. If we bring the resolution up to 300 dpi we lose same print 5

arinters,
3 d rnagL

nches, &5

inches (opposite, upper ignt). Itis possible Lo break the strict interdependence of the two factors viz 8 process
krown as resamplirg, but thereis a rule of ciminisnirg returns ¥ you resample too high. Here | have resamplec

the im resolution

zoe to sgueeze same more size pul ol a 240 0o
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Image Size

Pixel Dimensions: 16.9M

Wi%: 3008

Height: 1960

pixels

pixels

Document Size:

width: [12.533

|[inches v

Height: | 8.167 nches V' !

Resolution: | || pixelsfinch v_!

[[JResample Image:

Image Size

Pixel Dimensions: 16.9M

k width: 3008 pixels
Height: 1960 pixels
Document Size:
Width: | 10.027 || inches
Height: | 6.533 || inches

Resolution: |_300

[ ]Resample Image:

| :_ pixels/inch v ]

Image Size

Pixel Dimensions: 21.0M (was 16.9M)
width: [3360 || pixels v
Height: |2189 | puels

Document Size:

|[inches v =
[l
Height: [9.122 | inches v |

Wwidth: | 14

240

| pixels/inch v |

Resolution:

[]scale Styles
Constrain Proportions

Resample Image: | Bicubic
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PRINT SIZE AND RESOLUTION

The next step is to make sure you set up the image so it
has the proper resolution for your printer. You do this in
the Image=Image Size dialog box. Open any image on the
screen and open the Image Size dialog box. Here you'll
see the number of pixels that compose the image, the file
size, and the resolution of the image itsell.

When you first open the image you might see a screen
resolution of 72 dpi (most digital cameras yield images at
this resolution number). You must change this number to
print. If you don’t change the number, your image will be
quite large, but will break up—a resolution of 72 is too
small to yield a good print. Change this number to 300
dpi or 240 dpi (a good number for most printers.| If you
scan from film vou can change this number during
scanning.

PROFILING

When you input the new resolution number, the image
size will decrease. If the image is smaller than you'd like it
to be, you can resample, or interpolate, the image informa-
tion. To do this check the resample box at the base of the
image-size dialog box. As you change the size at the same
resolution you'll see the file size grow, bul since you are not
adding new image information, at some point the image will
start to degrade. That is, the image may not have enough
pixels to stand up to enlargement. When | resample in Pho-
toshop | do so in increments of about 10 to 20 percent. Spe-
cial resampling tools are available, but I have gotten the
same results using this step-by-step method.

Click OK to accept the new resolution and image size
and go to the File menu and scroll down to Print. The
Print dialog box will open up, and you will be prompted
[o set certain components, outlined below.

l A profile tells the printer how much ink to lay down when using certain kinds of paper,
i and is specific to a particular ink-and-paper combination and to the printer you are

download the files.

using. Print on glossy paper with matte selected and you'll have poor ink lay down, i
which may result in muddy colors and pooling that will not dry correctly. Choose glossy .
with matte paper loaded and the results might be thin with poor coverage. If you use ’
the printer manufacturer's brand of paper for your specific printer, there's a good
chance that the profile is already loaded in the printer driver.

You can find the profile for the specific ink, paper, and printer you use on most paper
company web sites under the Resources or ICC Profile heading (this information is also |
included on some paper packaging). You then download the profile and copy it into |
your operating system. In some cases the company might recommend equivalent 5
settings that are matched to printer brand papers.

In general, here's where you load the profiles; make sure to read the instructions
for your system carefully and follow any other instructions on the web site before you

* |n Windows 95/98/98SE and ME operating systems: C:\Windows\System\Color folder
® |n Windows 2000 and XP: C\WinNT\System32\Color folder

® |n some Windows XP systems: C:\Windows\System32\Spool\Drivers\Color folder.

e [n Mac 0S X: Users/l_ibrary/ColorSyn_c/Proﬁles

e |n Mac OS 9: System Folder: ColorSync Profiles

® In Mac 8.5 and earlier: System Folder: Preferences: ColorSync Profiles

By the time you read this there may be new versions of operating systems or changes ¢ |
in the way these profiles should be loaded; so, if your printer isn't laying down ink '

properly, check with the manufacturer.
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When yvou get to the actual printing stage,
begin with File=Print with Preview. Tne dialog

position box ascerlzins your initial settings and allows
Fo fnches v you to modily them as required. Always check
the Show More Options or Advanced box. Here
Left: h b , . . :
oones are Lhe sellings far an Epson 2200 printer,
[#] center Image
Scaled Print Size
Scale: 100% [Jscale ta Fi Media
Height: 10.5 nches b b ]
Width: 8.249 nches ¥
[]Show Bounding Box
Sh0w More Options
Color Management »
Source Space:
Document: () Document: Dot Gain 20%
Proof: (@) Proof Setup: U.5. Web Coated (SWOP) v2
Print Space;
Profile: | SP2200 Pramium Glossy_PK "
Intent: | Absolute Colarmetnc v
; : If everything is set in the Print with Freview
Print @ nox, click on tne Print button and you will enter
the printer driver settings box, Tnis serves as
Printer the aceess to the Properties dialog nox.

Name: Epson Stylus Photo 1270 ESC/P 2 v

Status: Ready
Type: Epson Stylus Photo 1270 ESC/P 2
Where: USB0O05

Comment [ ]Printto file
Printrange Copies
@ Al Number of copies: 1 =

[ OK ] [ Cancel
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PRINTER SETTINGS
When you're ready to print, go to File>Print with Pre-
view. Make sure that the size of the paper you are using
[8.5x11, Letter, 11x14, etc.) matches the indications in
this box. [t's important to check each time you print, as it
may revert to a default setting that does not match the
size paper you might be using at the time. If you always
use one size of paper, change the default to that size.
Next find the Color Management section, which you
might have to open by clicking on a box that says Show

More Options. If you set the printer up correctly, every-
thing should be set here. If not, change the settings.

You're now ready to hit the Print button. You can save
the settings and call them up when you go to print the
next time [using the Save Setting button in the Properties
dialog box). But don't be afraid to play with these settings
and to experiment with different types of images on vari-
ous papers. For the most part, however, sticking with one
or just a few different paper types, and learning how to
get the most from them, is the best course.

Wany print drivers will create @ checklist that
may nawe more or less information than

shown here In many cases you can save the
settings, name them {such as "line art matte”

or "commercial glossy"), and load them later
s tnal you don't have to go through this
while process every time you print.

Paper Source: Sheet

Paper Type: Premium Glossy Photo Paper
Quality: Photo - 1440dpi

Paper Size: A3(11.7x16.5in)
Orientation: Portrait

Modified Advanced Settings

None

Close
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%% EPSON Stylus Photo 2200 Properties

7 x [y : =
(W Main | (49 Page Layout Q’? Maintenance

Paper & Quality Options Color Management

[Sheet _~ | ™ Borderless " Color Controls

[Premium Glossy Photo Paper ] (" PhotoEnhance
® [CM

[SuperPhoto - 2880dpi -]

[A3(11.7x1651n) ~] 1CC Profiie

® No Color Adjusiment
Orientation

@ Portrait (" Applied by Printer Software

(" Landscape

Print Options [
[~ Reverse Order
[ Minimize Margins [

3]

[ High Speed

[ Black Ink Only
[v Edge Smoothing
[ Print Preview

|Custom Settings

Ink Config

| Saveseting [ Showthis screen first

Basic

[ ok ][ cancet ][ Help

& EPSON Stylus Photo 2200 Properties

. £
€& Main| 1 Page Layout| (5 Maintenance

Nozzie Check (N)
a Use this utility if gaps or faint areas appear in your
printout.

Head Cleaning (H)

b

Use this utility if your print quality declines or the
MNozzle Check indicates clogged nozzles.

Frint Head Alignment (F)
A SRR —
Use this utility if misaligned vertical lines appear

in your printout. .

Printer and Ogtion Information (O)

&

NEZ = 3 ;

B Use this utility to create or verify settings for your
ptinter and optional devices.

Speed & Progress [

Yersion 5.40

l OK J | Cancel ] [ Help

Again, double check all your settings here and
make sure they match the size of the paper, the
paper surface, and tne printer. Perhaps the
mast important tning you might have o do
here is to make sure that you've checked No
Colar Agjustment or Mo Coler Management.
This ensures thal there is no conflict between
Photosnop and print-driver color settings,

If vou have trouale with yaur printer, the
nozzles may ve clogged [a sure thing if you
don't use the printer reqularly) ar the heads
may need alignment. Click an the Maintenance
nutton to run the machine through some
glagnostics.
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GLOGSARY

Adjustment Layers: A collection of filters, each ol
which can affect nearly every pixel in an image. They
allow you to convert color to black and white, alter con-
trast, change exposure, etc., and each allows you to nu-
ance, or turn down, any effect.

Bit: A binary digit that is the smallest piece of information
used by a computer.

Bit Depth: In imaging, the number of pixels used to de-
scribe pixels. The greater the bit depth the more informa-
tion is described.

Blending Modes: Tools that increase exposure (Multi-
ply], decrease exposure (Screen|, change contrast by
about one step (Overlay|, and more.

Brightness: The luminance of objects. The brightness of
any area of the subject is dependent on how much light
falls on it and how reflective it is.

Burning: The selective increase, or darkening, of tonality
in certain areas of a scene.

Byte: A group of 8 bits, used by the computer as units of
information.

Channel Mixer: A highly effective tool for converting
color to black and white.

Color Balance: A setting that matches the available or
artificial light and faithfully renders color. It can also be
used to alter the lighting effect and can act as a form of
color cast or mood.

Compression: Shrinking a file’s size. Some compression

schemes discard file information in the process; others do
not. The image information is reconstructed when the file
is opened again.

Contrast: The relationship between the lightest and dark-
est areas in a scene and/or photograph. A small difference
means low contrast; a great difference, high contrast.

Curves: A tool that allows you to control both the overall
contrast and distinct tonal values within your image.

Desaturate: A tool that removes color but keeps an
image in RGB mode.

Digital Darkroom: Jargon for image processing pro-
grams, papers, inks, and printers used to edit and manipu-
late digital images.
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Digitize: To convert analog (film, print| information to
digital form by use of a scanner, digital sensor, or camera.

Dodging: The selective reduction, or lightening, of tonal-
ity in certain areas of a scene.

DPI: Dots per inch. The output resolution.

File Format: An arrangement of digital information that
may be particular to an application or generally adopted
for use by a wide range of devices. Image formats in wide
use include JPEG, TIFFE, GIF and increasingly, RAW.

Fill: A technique that allows you to bring tonal information
into image areas. It does not affect image detail, just tone.

Fill Flash: Fill-in flash, usually used outdoors to balance
the exposure of a subject that is backlit.

Filters: In computer-imaging software, a set of instruc-
tions that shapes or alters image information.

Flat: Low in contrast. Flat light shows little or no change
in brightness value throughout the entire scene.

Format: In memory cards, the type of card, such as Com-
pactFlash, SD (Secure Digital}, etc. In image files, the
choice of JPEG, TIFF, etc.

Grayscale: The range of tones, from bright white to pitch
black, that can be reproduced in a print.

Highlights: The brightest parts of a scene that yield tex-
ture ar image information.

High Resolution: A relative term that defines the input
and output quality of digital images (for example, sharp-
ness, continuous tone|.

Histogram: A graphic representation of tonal values that
can indicate where to make adjustments.

Hue: Color, as defined by words such as yellow, blue,
pink, etc.

Image Processor: The microprocessor in the camera
that integrates image information received from the sen-
sor. It can also add image attributes as described by the
photographer at the time of exposure.

JPEG: Acronym for Joint Photographic Experts Group. A
type of graphics file format that is often used for com-
pressing large image files for transmission or display.
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Layer: [n image manipulation, an effect that is superim-
posed on an image that does not change the underlying
pixels.

Layer Mask: A modification of a Layer thal works by

erasing some of the overlying Layer to reveal the Layer in-

formation underneath.

Layers Palette: An information area that shows the
background, or original image, and the various other Lay-
ers you have created. [t can also be used to modify vari-
ous Layers as needed with Opacity sliders, Blending
Modes, and more.

Levels: Displays the contrast range and allows you to
nodify it, then redistributes the tonal values throughout
the image.

Memory Card and Memory Card Reader: A memory
card is the common name for a PCMCIA, CompactHash,
SD, Memory Stick, xD, or similar type of card used in a
digital camera. A memory card reader is a small device

that patches right into the computer for easy downloading.

Microprocessor: A combination of transistors that per-
forms specific operations. Microprocessors are found in
computers and all digital cameras.

Multi-sampling: Making two or mare scans of the same
image.

Noise: A random pattern of pixels that interferes with an
image. Usually associated with low light, long exposure,
or high ISO images.

Overexposure: In exposure, when too much light
strikes the sensor [or a proper rendition of the scene.
Pixel: The picture element that forms the basis for digital
imaging.

Pixel Resolution: The pixels per inch in an image, such
as 640 x 480.

Plug-ins: Software that supplements image effects offered
in standard image-editing and manipulation programs.

Usually affords special effects and specific tasks with push-
button ease.

PPI: Pixels per inch, the basis for figuring image size, file
size, and, ultimately, image quality.

RAM: Random access memory. The memory that stores
data as an image Is being worked on. For image process-
ing, the more RAM the better.

Raw: A proprietary image file format. Raw is the image
information as delivered by the sensor and is not exten-
sively processed in the image processor of the camera.

Resolution: In digital imaging, the number of pixels per
inch (ppi) in an image.

RGB: Red, green, blue. The channels that make up a
color digital image.

Saturation: In color, a vividness, or intensity.

Step Wedge: A representation of the grayscale spectrum
of tonal values that shows how these might break, or be-
come distinct, on the print.

Stop: A relative measure of light that can be used to de-
scribe an aperture or shutter speed. A difference of one
stop indicates half or double the amount of light.

TIFF: An acronym for Tagged Image File Format. An un-
compressed file format.

Tonality: The quality of light in a picture. Tones are the
range of dark to light that make up the recorded image,
and may or may not match the original brightness values
in the scene.

Tone Curve: A graph used in digital photography that
displays tonal range, which changes when the curve is
manipulated.

Variations: A tool thart allows vou to alter color, satura-
tion, and other qualities with one click.
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Add, and subtract, 126

Address, pixel, seleclors [or,
122-123

Adjustment Layers, 84-85

Adjustments, image, scanner
software and, 64, 66-67

Advantage, digital, 93

Amount, in Unsharp Mask, 111

Appreciation, 16-31

Art, 26-31

Black and white
appreciation of, 16-31
converting color to, 140

Black-and-white print. Seg

Print|s)

Blending Modes, 85

Brower, Carol, 148

Budgel papers, 150

Burn and Dodge, 93-95

Cameras, digital, 58-63

Canvas, 150

CDs, Picture, 65

Color, converling of, to black and
white, 140

Colorizing monochrome images,
132-145

Color Range, 122

Compressed tones, 37

Consistency, tonal, 46-49

Contiguous/non-contiguous
options, 126

Contrast, 38-43

Contral, highlight, 50-53

Converting color to black and
white, 140

Craft, 26-31

Curves, 96-105

Detail, shadow, 52-53
Diagnostic ools, 76-83
Diary, print, 11

Dietrich, Marlene, 46
Digital advantage, 93
Digital cameras, 58-63
D191 ral image files. See Files
Digital images. See [mages
D1g1La1 imaging software, 71
Digital sources, for files, 56-57, 69
Digital toolbox, 76

Dodge, Burn and, 93-95
Duotones, 139-141

Easy color options, 132-138
Elements, of print, 32-53
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Elliptical Marguee, 118, 119
Fquipment, basic, 54-73
Exposure, 44-45
Lyedropper, 122

Feathering, 124-125

File formats, and resolution,
60-63

Files, [ilm and digital sources for,
56-57, 60

File size, and print size, 58

Fill, tonal grabbers and, 106- 108

Film sources, for files, 5657, 69

Fine art papers, 150

Formats, file, and resolution,
00-03

Freehand tools, [16-117

Generic art papers, 150

Glossy papers, 150

(irabbers, wonal, and {ill,
[06-108

Growing selections, 127

Highlight contral, 5053
Histogram, 78-83
Hopper, Edward, 24
Hue/Saturation, 137

Image adjustments, scanner
software and, 64, 66-67
[mage files. See Files
[mages
choosing of, for wark, 71-73
monochrome, [(_Ill']c and
colorizing of, 132-145
Imaging software, 71
Ink, 146, 147,151
lnverse, selection, 127

[PEC format, 60, 63

Lasso, 116

Layer Masks, 8682

Layers, Adjustment, 84-85
Lavers paletie, 84

Legacy, 24-25

Levels, 96

Long-term stabiliry, prrinr:\:, 148
Looking, at print, 25

Magic Wand, 122
Magnetic Lasso, 116
Mask|s|
Layer, 8692
Unsharp, L11,
Martte papers, 15

112
0

Megapixels, sensor size and,
5859
Models)
Blending, 85
choosing of, 132, 151
Wiodifiers, selection, 124- 131
Monochrome images, toning and
colorizing of, 132-145

Nestalgia, 22-23
Numbers, scanner, 68

Paletle, Layers, 84
Paper, 146, 147, 148-150
Photographic print. See Printis)
Photo-Secessionists, 24, 25
Photoshop, 71, 76
Picture CDs, 65
Pixel address selectors, 122-123
Plug-ins, 71
Polyeon Lasso, 116, 117
Power, 1819
Printis), 20-21
elements of, 32-53
long-term stability of, 148
what Lo look for in, 2_)
Print diary, 11
Printer
paper for, 146, 147, 148-150
setup and seftings for,
152-157
Print size
file size and, 58
and resolution, 154-155
Profiling, 154

(luick Mask, 127, 128, 129

Radius, in Unsharp Mask, 111
Raphael, 24
Raw formar, 62, 63
Rectangular Marquee, 118, 120,
121,122
Rembrands:, 24
Rescue, through selections, 116
Resolution
file formats and, &0- ("\3
print size and, 154-1

Saturation, 132, 137
Scale, tonal, 34-37
Scanner options, 68
Scanners, 04-70

Scans, service bureau, 65
Select inverse, 127
Selection modiliers

16-123
gapixels,

Selection tools, |
Sensor size, and me
56-50
Service bureau scans, 65
Settings
scan, 69-70
setup and, for printer,
152-157
Setup options, Photoshop, 83
Snadow detail, 52-53
Shape selectors, 118121
Sharpening, 111-113

Siskind, Aaron, 24
Size
file, 58
print, 58, 154-155
sensor, 58

digital imaging, 71
scanner, ahd image
adjustments, 64, 6667

Sources, for files, 56-57, ﬁ’)
Special effects surfaces
Specialized tools, 114-145
Slep wedge, 76-77
Strand, Paul, 24
Sublract, add and, 126
Surface, paper, 150

Textured papers, 150
Threshold, in Unsharp tdask, 111
Tice, George, 24
TIFF format, 60, 63
Telerance, 126
Tonal consistency, 46-49
Tonal grabbers, and fill, 106- 108
Tonal scale, 34-37
Tones, compressed, 37
Toning and colorizing
monochrome images,
132-145
Tools
basic, 74-113
specialized, 114-145

lnsharp Mask, 111-112

Variations, 132-133
Viewing oplions, selection, 121
Von Stroheim, Eric, 46

White, Minar, 24

\"\"llhi:.,m, Henr Ya 148

Work, choosing images far,
71-73
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MASTER THE ARTISTRY OF
BLACK AND WHITE PRINTING

Black-and-white digital printing is one of the hottest topics in
photography these days. Why? Black and white expands a
photographet’s creative potential with a wealth of possibilities,
from restoring treasured vintage photographs to capturing the rich
tones and values that are unique to the medium to creating
timeless, documentary-style prints.

George Schaub, well-known author and teacher, provides all
the tips and techniques a photographer needs to create successful
black-and-white images, whether shooting digijtally or scanning
from prints and film. Step-by-step coverage will help you master:

Contrast, exposure, and the other elements of a good print

Burning and dodging, softening and sharpening, Blending modes
and Layer Masks, and all the other digital darkroom tools

Scanning, printing, and choosing papers.

Black and white may be as old as photography itself, but with
Amphoto’s Guide to Digital Black and White Printing, you can
tap into a new realm of exciting possibilities!

George Schaub is the best-selling author of Amphoto’s Guide to
Creative Digital Photography, Using Your Digital Camera, Professional
Techniques for the Wedding Photographer, Using Your Camera, and
many other books. He is the editorial director of Shutterbug and
eDigital Photo magazines and lectures on digital black-and-white
printing internationally.
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